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Introduction to the KiCad Schematic Editor
概要
The KiCad Schematic Editor is a schematic capture software distributed as a part of KiCad and available
under the following operating systems:

Linux

Apple macOS

Windows

Regardless of the OS, all KiCad files are 100% compatible from one OS to another.

The Schematic Editor is an integrated application where all functions of drawing, control, layout, library
management and access to the PCB design software are carried out within the editor itself.

The KiCad Schematic Editor is intended to cooperate with the KiCad PCB Editor, which is KiCad’s printed
circuit design software. It can also export netlist files, which lists all the electrical connections, for other
packages.

The Schematic Editor includes a symbol library editor, which can create and edit symbols and manage
libraries. It also integrates the following additional but essential functions needed for modern schematic
capture software:

誤接続、未接続の自動的な検出を行うエレクトリカル・ルール・チェック (ERC)

多くの形式 (Postscript, PDF, HPGL, SVG) をサポートしたプロットファイルのエクスポート。

（様々なフォーマットを設定できるよう Python か XSLT のスクリプトを使用した）部品表 (BOM) の生成。

技術的な概要
The Schematic Editor is limited only by the available memory. There is thus no real limitation to the number
of components, component pins, connections or sheets. In the case of multi-sheet schematics, the
representation is hierarchical.

The Schematic Editor can use multi-sheet schematics in a few ways:

単一の階層 (各図が一度だけ使用される)。

複雑な階層 (いくつかの図は、一度以上の複数回使用される)。

平面的（フラット）な階層 (マスター図面の中、いくつかの図面は明示的に接続されない)。
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Generic Schematic Editor commands
下記のコマンドを実行できます :

画面上部のメニューバーをクリックする。

画面上部のアイコンをクリックする （一般コマンド）。

画面右側のアイコンをクリックする（特殊コマンド、または “ツール” ）。

画面左側のアイコンをクリックする（表示オプション）。

マウスボタンをクリックする（重要な補助コマンド）。特に右クリックでは、カーソル下の要素に対応したコ
ンテキストメニューを開きます（ズーム、グリッドと要素の編集）。

Function keys ( , , , ,  and ). Specifically:  cancels the command in
progress.  allows the duplication of the last element created.

Pressing hotkeys. For a list of hotkeys, see the Help→List Hotkeys menu entry or press + . Many
hotkeys select a tool but do not perform the tool’s action until the canvas is clicked. This behavior can be
changed by unchecking First hotkey selects tool in the Common Preferences pane. With this option
unchecked, pressing a hotkey will select the tool and immediately perform the tool’s action at the current
cursor location.

F1 F2 F3 F4 Insert Space Escape

Insert

Ctrl F1
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マウスコマンド
基本コマンド
左ボタン

Single click: Selects the item under the cursor and displays the item’s characteristics in the status bar.

Double click: edits the item if it is editable.

Long click (click and hold): opens a pop-up menu to clarify the selection.

右ボタン

Opens a pop-up menu. If an item is selected, the items in the menu are related to the selected item. If an
item is under the cursor when the right mouse button is clicked, the item is selected.

Selection operations
Schematic editor items can be selected by clicking on them. Multiple items can be selected at once. Add items
to the selection with  + click, and remove items from the selection with +  + click.

NOTE On Apple keyboards, use the  key instead of .

left mouse button Select item.

 + left mouse button Add item to selection.

+  + left mouse button Remove item from
selection.

long click Clarify selection from a
pop-up menu.

 + left mouse button Highlight net.

Items can also be selected by drawing a box around them using the left mouse button.

Dragging from left to right includes all items fully enclosed by the box. Dragging from right to left includes
all items touched by the box, even if they are not fully enclosed.

The  and +  modifiers also work with drag selections to add and remove items from the
selection, respectively.

ホットキー
The +  displays the current hotkey list.

All hotkeys can be redefined using the hotkey editor (Preferences → Preferences…  → Hotkeys).

The default hotkey list is below. Many additional actions do not have hotkeys by default, but hotkeys can be
assigned to them with the hotkey editor.

Shift Ctrl Shift

Cmd Ctrl

Shift

Ctrl Shift

Ctrl

Shift Ctrl Shift

Ctrl F1
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The hotkeys described in this manual use the key labels that appear on a standard PC keyboard. On an Apple
keyboard layout, use the  key in place of , and the  key in place of .

Action Default
Hotkey

Description

Click Performs left mouse button click

Double-click Performs left mouse button double-click

Cursor Down

Cursor Down Fast +

Cursor Left

Cursor Left Fast +

Cursor Right

Cursor Right Fast +

Cursor Up

Cursor Up Fast +

Switch to Fast Grid
1

+

Switch to Fast Grid
2

+

Switch to Next
Grid

Switch to Previous
Grid

+

Reset Grid Origin

Grid Origin Set the grid origin point

New… + Create a new document in the editor

Open… + Open existing document

Pan Down +

Pan Left +

Pan Right +

Pan Up +

Print… + Print

Cmd Ctrl Option Alt

Return

End

Down

Ctrl Down

Left

Ctrl Left

Right

Ctrl Right

Up

Ctrl Up

Alt 1

Alt 2

N

Shift N

Z

S

Ctrl N

Ctrl O

Shift Down

Shift Left

Shift Right

Shift Up

Ctrl P
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Action Default
Hotkey

Description

Reset Local
Coordinates

Save + Save changes

Save As… + + Save current document to another location

Always Show
Cursor

+ + Display crosshairs even in selection tool

Switch units + Switch between imperial and metric units

Update PCB from
Schematic…

Update PCB with changes made to schematic

Center Center

Zoom to Objects + Zoom to Objects

Zoom to Fit Zoom to Fit

Zoom In at Cursor Zoom In at Cursor

Zoom Out at
Cursor

Zoom Out at Cursor

Refresh Refresh

Zoom to Selection + Zoom to Selection

Change Edit
Method

+ Change edit method constraints

Copy + Copy selected item(s) to clipboard

Cut + Cut selected item(s) to clipboard

Delete Deletes selected item(s)

Duplicate + Duplicates the selected item(s)

Find + Find text

Find and Replace + + Find and replace text

Find Next Find next match

Find Next Marker +

Paste + Paste item(s) from clipboard

Space

Ctrl S

Ctrl Shift

S

Ctrl Shift

X

Ctrl U

F8

F4

Ctrl Home

Home

F1

F2

F5

Ctrl F5

Ctrl Space

Ctrl C

Ctrl X

Del

Ctrl D

Ctrl F

Ctrl Alt

F

F3

Shift F3

Ctrl V
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Action Default
Hotkey

Description

List Hotkeys… + Displays current hotkeys table and corresponding commands

Preferences… + Show preferences for all open tools

Clear Net
Highlighting

Clear any existing net highlighting

Edit Library
Symbol… 

+ + Open the library symbol in the Symbol Editor

Edit with Symbol
Editor

+ Open the selected symbol in the Symbol Editor

Highlight Net Highlight net under cursor

Show Datasheet Opens the datasheet in a browser

Add Sheet Add a hierarchical sheet

Add Wire to Bus
Entry

Add a wire entry to a bus

Add Global Label + Add a global label

Add Hierarchical
Label

Add a hierarchical label

Add Junction Add a junction

Add Label Add a net label

Add No Connect
Flag

Add a no-connection flag

Add Power Add a power port

Add Text Add text

Add Symbol Add a symbol

Add Bus Add a bus

Add Lines Add connected graphic lines

Add Wire Add a wire

Finish Wire or Bus Complete drawing at current segment

Unfold from Bus Break a wire out of a bus

Autoplace Fields Runs the automatic placement algorithm on the symbol or sheet’s
fields

Ctrl F1

Ctrl ,

~

Ctrl Shift

E

Ctrl E

`

D

S

Z

Ctrl L

H

J

L

Q

P

T

A

B

I

W

K

C

O
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Action Default
Hotkey

Description

Mirror Vertically Flips selected item(s) from top to bottom

Properties… Displays item properties dialog

Repeat Last Item Duplicates the last drawn item

Rotate
Counterclockwise

Rotates selected item(s) counter-clockwise

Drag Drags the selected item(s)

Move Moves the selected item(s)

Select Connection + Select a complete connection

Select Node + Select a connection item under the cursor

Leave Sheet + Display the parent sheet in the schematic editor

Hotkeys are stored in the file user.hotkeys  in KiCad’s configuration directory. The location is platform-
specific:

Windows: %APPDATA%\kicad\6.0\user.hotkeys

Linux: ~/.config/kicad/6.0/user.hotkeys

macOS: ~/Library/Preferences/kicad/6.0/user.hotkeys

It is possible to import hotkey settings from a user.hotkeys  file using menu Preferences→Preferences… 
→Hotkeys→Import Hotkeys… .

グリッド
In the Schematic Editor the cursor always moves over a grid. The grid can be customized:

Size can be changed using the right click menu or using View → Grid Properties… .

Color can be changed in the Colors page of the Preferences dialog (menu Preferences → General
Options).

Visibility can be switched using the left-hand toolbar button.

The default grid size is 50 mil (0.050") or 1.27 millimeters.

これは回路図上で配線や部品を配置したり、シンボル・エディター上で回路記号のピンを配置するのに適したグリ
ッド・サイズです。

NOTE

Wires connect with other wires or pins only if their ends coincide exactly. Therefore it is
important to keep symbol pins and wires aligned to the grid. It is recommended to always
use a 50 mil grid when placing symbols and drawing wires because the KiCad standard
symbol library and all libraries that follow its style also use a 50 mil grid.

Y

E

Ins

R

G

M

Alt 4

Alt 3

Alt Back
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NOTE Symbols, wires, and other elements that are not aligned to the grid can be snapped back to
the grid by selecting them, right clicking, and clicking Align Elements to Grid.

Snapping
Schematic elements such as symbols, wires, text, and graphic lines are snapped to the grid when moving,
dragging, and drawing them. Additionally, the wire tool snaps to pins even when grid snapping is disabled.
Both grid and pin snapping can be disabled while moving the mouse by using the modifier keys in the table
below.

NOTE On Apple keyboards, use the  key instead of .

Modifier Key Effect

Disable grid snapping.

Disable snapping wires to pins.

ズームの選択
ズームレベルを変えるには:

右クリックしてコンテキストメニューを開き、希望のズームを選択。

Or use hotkeys:

: Zoom in

: Zoom out

: Center the view around the cursor pointer position

: Zoom and center the view to fit the entire schematic sheet

+ : Zoom and center the view to fit all of the objects in the schematic

+ : Activate the Zoom to Selection tool

ウィンドウのズーム:

Mouse wheel: Zoom in/out

Shift+Mouse wheel: Pan up/down

Ctrl+Mouse wheel: Pan left/right

Mouse scroll gestures are configurable in the Mouse and Touchpad page of the Preferences dialog.

カーソルの座標表示
The display units are in inches, mils, or millimeters.

ウィンドウの下部右側には以下の情報が表示されます:

ズーム倍率

カーソルの絶対位置

Cmd Ctrl

Ctrl

Shift

F1

F2

F4

Home

Ctrl Home

Ctrl F5
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カーソルの相対位置

The grid size

The active unit system

The active tool

相対座標値 (x, y) はスペースキーで (0, 0) にリセットされます。これは２点間の距離を測る時に役立ちます。

上部メニューバー
上部メニューバーでは、回路図を保存したり、プログラム設定を開いたり、保存したり、ヘルプメニューを開いた
りできます。

上部ツールバー
This toolbar gives access to the main functions of the Schematic Editor.

If the Schematic Editor is run in standalone mode, this is the available tool set:

KiCad がプロジェクトモードで動いているときは、個別のファイルを扱うための最初の2つのアイコンは表示され
ません。

Create a new schematic (only in standalone mode).

Open a schematic (only in standalone mode).

Save complete schematic project.

Set the schematic-specific options.

Select the sheet size and edit the title block.

Open print dialog.

Open plot dialog.

Paste a copied/cut item or block to the current sheet.

Undo: Revert the last change.

Redo: Revert the last undo operation.

Show the dialog to search symbols and texts in the schematic.

Show the dialog to search and replace texts in the schematic.
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Refresh screen.

Zoom in.

Zoom out.

Zoom to fit the entire schematic sheet.

Zoom to fit all objects in the schematic.

Zoom to fit selected items.

View and navigate the hierarchy tree.

Leave the current sheet and go up in the hierarchy.

Rotate selected items counter-clockwise.

Rotate selected items clockwise.

Mirror selected items vertically.

Mirror selected items horizontally.

Call the symbol library editor to view and modify libraries and symbols.

Browse symbol libraries.

Open the footprint library editor to view and modify libraries and footprints.

Annotate symbols.

Electrical Rules Checker (ERC), automatically validate electrical connections.

Open the footprint assignment tool to assign footprints to symbols.

Bulk edit symbol fields in a spreadsheet interface.

Generate the Bill of Materials (BOM).

Open the PCB editor.

Open the Python scripting console.

右ツールバーのアイコン
このツールバーは次のツールを含んでいます:

シンボル、ワイヤー、バス、ジャンクション、ラベル、テキストの配置

階層サブシートと接続シンボルの作成
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Cancel the active command or tool and go into selection mode.

Highlight a net by marking its wires and net labels with a different color. If the PCB Editor is
also open then copper corresponding to the selected net will be highlighted as well.

Display the symbol selector dialog to select a new symbol to be placed.

Display the power symbol selector dialog to select a power symbol to be placed.

Draw a wire.

Draw a bus.

Draw wire-to-bus entry points. These elements are only graphical and do not create a
connection, thus they should not be used to connect wires together.

Place a "No Connect" flag. These flags should be placed on symbol pins which are meant to be
left unconnected. It is done to notify the Electrical Rules Checker that lack of connection for a
particular pin is intentional and should not be reported.

Place a junction. This connects two crossing wires or a wire and a pin, when it can be
ambiguous (i.e. if a wire end or a pin is not directly connected to another wire end).

Place a local label. Local label connects items located in the same sheet. For connections
between two different sheets, you have to use global or hierarchical labels.

Place a global label. All global labels with the same name are connected, even when located on
different sheets.

Place a hierarchical label. Hierarchical labels are used to create a connection between a
subsheet and the parent sheet that contains it.

Place a hierarchical subsheet. You must specify the file name for this subsheet.

Import a hierarchical pin from a subsheet. This command can be executed only on hierarchical
subsheets. It will create hierarchical pins corresponding to hierarchical labels placed in the
target subsheet.

Draw a line. These are only graphical and do not connect anything.

Place a text comment.

Place a bitmap image.

Delete clicked items.

左ツールバーのアイコン
このツールバーは表示オプションを管理します:
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Toggle grid visibility.

Switch units to inches.

Switch units to mils (0.001 inches).

Switch units to millimeters.

Choose the cursor shape (full screen/small).

Toggle visibility of "invisible" pins.

Toggle free angle/90 degrees wires and buses placement.

コンテキストメニューとクイックエディット
右クリックで選択要素に応じたコンテキストメニューを開き、下記の機能にアクセスします:

ズーム倍率。

グリッド調整。

Copy/Paste/Delete commands.

Add Wire/Bus.

パラメータ編集。
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上部メニューバーの主なメニュー
ファイルメニュー
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New Close current schematic and start a new one (only in standalone
mode).

Open Load a schematic project (only in standalone mode).

Open Recent Open a schematic project from the list of recently opened files (only in
standalone mode).

Save Save current sheet and all its subsheets.

Save As… Save the current sheet under a new name (only in standalone mode).

Save Current Sheet Copy As… Save a copy of the current sheet under a new name (only in project
mode).

Insert Schematic Sheet
Content… 

Insert the contents of another schematic sheet into the current sheet
(only in standalone mode).

Import Import a non-KiCad schematic or a footprint assignment file.

Export Export a netlist or a drawing of the schematic to the clipboard.

Schematic Setup… Set up schematic formatting, electrical rules, net classes, and text
variables.

Page Settings… Configure page dimensions and title block.

Print Print schematic project (See also chapter Plot and Print).

Plot Export to PDF, PostScript, HPGL or SVG format (See chapter Plot and
Print).

Quit Terminate the application.

Schematic Setup
The Schematic Setup window is used to set schematic options that are specific to the currently active
schematic. For example, the Schematic Setup window contains formatting options, electrical rule
configuration, netclass setup, and schematic text variable setup.
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設定メニュー

Configure Paths… Set the default search paths.

Manage Symbol Library
Tables… 

Add/remove symbol libraries.

Preferences… Preferences (units, grid size, field names, etc.).

Set Language Select interface language.
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シンボル ライブラリー テープルの管理

KiCad uses two library tables to store the list of available symbol libraries, which differ by the scope:

グローバル ライブラリー
Libraries listed in the Global Library table are available to every project. They are saved in the sym-lib-
table  in the KiCad configuration directory, which is system-dependent:

Windows: %APPDATA%\kicad\6.0\sym-lib-table

Linux: ~/.config/kicad/6.0/sym-lib-table

macOS: ~/Library/Preferences/kicad/6.0/sym-lib-table

プロジェクト固有のライブラリー
Libraries listed in Project Specific Libraries table are available to the currently opened project. They are
saved in a sym-lib-table  file in the project directory.
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Both library tables are visible by clicking on Global Libraries or Project Specific Libraries tab in the
Manage Library Tables window.

ライブラリーを追加
Add a library either by clicking the  button and selecting a file or clicking the  button and typing a path
to a library file. The selected library will be added to the currently opened library table (Global/Project
Specific).

ライブラリーを削除
Remove a library by selecting one or more libraries and clicking the  button.

ライブラリーのプロパティ
テーブルの各行は、いくつかのフィールドでライブラリーの情報を表示しています :

Active Enables/disables the library. It is useful to temporarily reduce the loaded
library set.

Nickname Nickname is a short, unique identifier used for assigning symbols to
components. Symbols are represented by '<Library Nickname>:<Symbol
Name>' strings.

Library Path Path points to the library location.

Plugin Type Determines the library file format. KiCad 6.0 libraries use the "KiCad"
format, while KiCad 5.x libraries use the "Legacy" format. Legacy
libraries are read-only.

Options Stores library specific options, if used by plugin.

Description Briefly characterizes the library contents.

設定
Common Preferences

NOTE TODO: write this section



19

Mouse and Touchpad

Center and warp cursor on zoom If checked, the pointed location is warped to the screen center
when zooming in/out.

Use touchpad to pan When enabled, view is panned using scroll wheels (or
touchpad gestures) and to zoom one needs to hold .
Otherwise scroll wheels zoom in/out and /  are the
panning modifiers.

Pan while moving object If checked, automatically pans the window if the cursor leaves
the window during drawing or moving.

ホットキー
Redefine hotkeys.

Ctrl

Ctrl Shift
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アクションをダブルクリックか右クリックすると、ポップアップメニューが表示されます :

Edit Define a new hotkey for the action (same as double click).

Undo Changes Reverts the recent hotkey changes for the action.

Clear Assigned Hotkey

Restore Default Sets the action hotkey to its default value.

Display Options
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Grid Size Grid size selection.

It is recommended to work with normal grid (0.050 inches or
1,27 mm). Smaller grids are used for component building.

Bus thickness Pen size used to draw buses.

Line thickness Pen size used to draw objects that do not have a specified pen
size.

Part ID notation Style of suffix that is used to denote symbol units (U1A, U1.A,
U1-1, etc.)

Icon scale Adjust toolbar icons size.

Show Grid Grid visibility setting.

Restrict buses and wires to H and V
orientation

If checked, buses and wires are drawn only with vertical or
horizontal lines. Otherwise buses and wires can be placed at
any orientation.

Show hidden pins: Display invisible (or hidden) pins, typically power pins.

Show page limits If checked, shows the page boundaries on screen.

Footprint previews in symbol chooser Displays a footprint preview frame and footprint selector
when placing a new symbol.

Note: it may cause problems or delays, use at your own risk.
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Editing Options
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Measurement units Select the display and the cursor coordinate units (inches or
millimeters).

Horizontal pitch of repeated items Increment on X axis during element duplication (default: 0)
(after placing an item like a symbol, label or wire, a
duplication is made by the  key)

Vertical pitch of repeated items Increment on Y axis during element duplication (default:
0.100 inches or 2,54 mm).

Increment of repeated labels Increment of label value during duplication of texts ending in
a number, such as bus members (usual value 1 or -1).

Default text size Text size used when creating new text items or labels.

Auto-save time interval Time in minutes between saving backups.

Automatically place symbol fields If checked, symbol fields (e.g. value and reference) in newly
placed symbols might be moved to avoid collisions with other
items.

Allow field autoplace to change
justification

Extension of 'Automatically place symbol fields' option.
Enable text justification adjustment for symbol fields when
placing a new part.

Always align autoplaced fields to the 50
mil grid

Extension of 'Automatically place symbol fields' option. If
checked, fields are autoplaced using 50 mils grid, otherwise
they are placed freely.

色
様々な要素の描画色です。色見本をクリックすると、その要素の新しい色を選択できます。

Insert
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デフォルトのフィールド
シンボルに配置される追加のカスタムフィールドや関連する値を定義します。



25

ヘルプ・メニュー
KiCad についての広範囲なチュートリアルについては、オンラインヘルプ（この文書）にアクセスします。

Use the Report a Bug item to report a bug online. Full KiCad version and user system information is
available via the Copy Version Info button in the About KiCad window.
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上部ツールバーの主なツール
ページ設定
The Sheet Settings icon ( ) allows you to define the sheet size and the contents of the title block.

シートの数やシート番号といったデータは、自動的に更新されます。左向き矢印のボタンを押すと今日の日付を
“変更日” の日付に設定することができますが、自動的には更新されません。

検索ツール
The Find icon ( ) can be used to access the search tool.

現在のシートあるいは階層全体内にある、リファレンス、値、テキスト文字列を検索することができます。見つか
ると、関係するサブシートの見つかった要素の上にカーソルが移動します。

ネットリストツール
The Netlist icon ( ) opens the netlist generation tool.

このツールは、階層全体（通常のオプション）の全ての接続を記述するファイルを作成します。

マルチシートの階層において、ローカルラベルは自身が属するシート内だけで通用します。例えば、シート 3 のラ
ベル 1 は、（意図的にそれらを接続していない場合）シート 5 のラベル 1 とは接続されません。これは、シート名
がローカルラベルと関連付けられているからです。
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NOTE Even though there is no text length limit for labels in KiCad, please take into account that
other programs reading the generated netlist may have such constraints.

NOTE
Avoid spaces in labels, because they will appear as separated words in the generated file.
It is not a limitation of KiCad, but of many netlist formats, which often assume that a label
has no spaces.

オプション：

デフォルトの出力形式 チェックすると、デフォルトのフォーマットで Pcbnew を開きま
す。

以下のような他のフォーマットも生成できます:

Orcad PCB2

CadStar

Spice （シミュレータ用）

外部プラグインを追加してネットリスト フォーマット リストを拡張できます（下記に示す PadsPcb プラグインな
ど）。

ネットリストの作成 にネットリスト作成に関する詳しい情報があります。

アノテーションツール
The icon  launches the annotation tool. This tool assigns references to components.

複数ユニットコンポーネント（４ゲート入りの 7400 TTL など）には、マルチパート (multi-part) の接尾辞が割り
当てられます。従って、U3に指定された7400 TTL は、U3A、U3B、U3C、U3D に分かれます。

無条件に全てのコンポーネントを、もしくはまだアノテートされていない新規のコンポーネントだけを、アノテー
トできます。



28

実行範囲

Use the entire schematic All sheets are re-annotated (default).

Use the current page only Only the current sheet is re-annotated (this option is to be
used only in special cases, for example to evaluate the amount
of resistors in the current sheet.).

Keep existing annotation Conditional annotation, only the new components will be re-
annotated (default).

Reset existing annotation Unconditional annotation, all the components will be re-
annotated (this option is to be used when there are duplicated
references).

Reset, but do not swap any annotated
multi-unit parts

Keeps all groups of multiple units (e.g. U2A, U2B) together
when reannotating.

アノテーションの順番

コンポーネントの番号付けを行う順番（水平方向か垂直方向か）を選択します。

アノテーションの選択

割り当てられたリファレンスのフォーマットを選択。

エレクトリカル・ルール・チェック (ERC) ツール
The icon  launches the electrical rules check (ERC) tool.

このツールは設計の検証を行い、接続忘れや矛盾を検出できます。

Once you have run the ERC, KiCad places markers to highlight problems. The error description is displayed
after left clicking on the marker. An error report file can also be generated.
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ERC ダイアログ：ERC

エラーはエレクトリカル・ルール・チェック (ERC) ダイアログに表示されます ：

合計（エラーと警告の合計数）

警告（警告の発生数）

エラー（エラーの発生数）

オプション：

ERC レポートファイルの生成 ERC レポートファイルを生成するには、このオプションをチェッ
クします。

コマンド：

マーカーを削除 全ての ERC エラー/警告マーカーを削除します。

実行 ERC （エレクトリカル ルール チェック）を実行します。

閉じる ダイアログを閉じます。

エラーメッセージをクリックすると、回路図の対応するマーカーにジャンプします。



30

ERC ダイアログ：オプション

このタブページで、ピン間の接続ルールを定義できます。それぞれのケースに対して、3つのオプションから選択
できます。:

エラーなし（No error： 緑）

警告（Warning： 黄）

エラー（Error： 赤）

マトリックスのそれぞれの四角上でクリックすることにより、内容を変更できます。

オプション：

同様のラベルを確認 大文字小文字だけが異なるラベル（例: label/Label/LaBeL）を報
告します。 ネット名は大文字と小文字を区別するため、このよう
なラベルは別のネットと認識されます。

固有のグローバルラベルを確認 一度しか使われていないグローバルラベルを報告します。通常、
最低2つは接続のために使われている必要があります。

コマンド：

デフォルトへ初期化 もともとの設定に戻します。

部品表 (BOM) ツール
The icon  launches the bill of materials (BOM) generator. This tool generates a file listing the

components and/or hierarchical connections (global labels).
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The Schematic Editor’s BOM generator makes use of external plugins, either as XSLT or Python scripts. There
are a few examples installed inside the KiCad program files directory.

部品表 (BOM) での使用に役立つコンポーネントのプロパティには、以下のものが挙げられます。:

定数 – 各部品で使用される固有の名前

フットプリント – 手入力、またはバックアノテートされたもの（下図参照）

フィールド１ – 製造業者名（任意、追加が必要）

フィールド２ – 製造業者の部品番号（任意、追加が必要）

フィールド３ – 販売業者の部品番号（任意、追加が必要）

例:
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Windows 環境 の BOM 作成ダイアログには、（赤い矢印で示している）外部プラグインで表示ウィンドウをコン
トロールするための特別なオプションがあります。デフォルトの設定では、 BOM 作成コマンドは隠れたウィンド
ウで実行され、 Plugin info フィールドに結果が表示されます。このオプションを有効にすると、実行中のウィン
ドウを表示します。 GUI でプラグインの動作確認を行う際に、この機能は必要になるでしょう。

フィールド編集ツール
The icon  opens a spreadsheet to view and modify field values for all symbols.
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フィールドの値を変更したら、'適用’ボタンをクリックして変更を受理するか、'元に戻す’ボタンをクリックして変
更を破棄する必要があります。

簡単にフィールドを埋める裏技
スプレッドシート中で実行する、いくつかの特別なコピー/ペーストの方法があります。これらは少数のコンポー
ネントで繰り返してフィールドの値を入力する時に役に立ちます。

These methods are illustrated below.
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Copy (Ctrl+C) Selection Paste (Ctrl+V)

NOTE これらのテクニックは、グリッド コントロールを持っている他のダイアログでも有効です。

フットプリント割当用インポート（バックアノテート）ツール :

アクセス:
The icon  launches the back-annotate tool.

This tool allows footprint changes made in the PCB Editor to be imported back into the footprint fields in
the Schematic Editor.



35

シンボル・ライブラリーの管理
シンボル・ライブラリーは、回路図を作成するときに使われるシンボルのコレクションを保持しています。回路図
中の各シンボルは、ライブラリーのニックネームとシンボル名から作られるフルネームで一意的に識別されま
す。 Audio:AD1853  は、その例です。

シンボル・ライブラリー・テーブル
シンボル・ライブラリー・テーブルは、KiCad が認識している全てのライブラリー・ファイルのリストを保持して
います。シンボル・ライブラリー・テーブルは、グローバル・シンボル・ライブラリー・テーブル・ファイルとプ
ロジェクト固有のシンボル・ライブラリー・テーブル・ファイルから構成されます。

When a symbol is loaded, KiCad uses the library nickname, Audio  in our example, to lookup the library
location in the symbol library table.

The image below shows the symbol library table editing dialog which can be opened by invoking the
Manage Symbol Libraries…  entry in the Preferences menu.
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グローバル・シンボル・ライブラリー・テーブル
The global symbol library table contains the list of libraries that are always available regardless of the
currently loaded project file. The table is saved in the file sym-lib-table in the user’s KiCad configuration
folder. The location of this folder is dependent upon the operating system being used.

プロジェクト固有のシンボル・ライブラリー・テーブル
プロジェクト固有のシンボル・ライブラリー・テーブルは、現在のプロジェクト・ファイルで明示的に有効となる
ライブラリーのリストを保持しています。プロジェクト固有のシンボル・ライブラリー・テーブルは、プロジェク
ト・ファイルと一緒にロードされている時のみ、編集可能です。プロジェクト・ファイルが読み込まれていない
か、プロジェクトのパスにシンボル・ライブラリー・テーブルがない場合、編集可能な空のテーブルが作られ、後
でプロジェクト・ファイルと一緒に保存されます。

初期設定
The first time the KiCad Schematic Editor is run and the global symbol table file sym-lib-table  is not found
in the KiCad configuration folder, KiCad will present the "Configure Global Symbol Library Table" dialog to
the user. The dialog presents the user with three options.

Copy default global symbol library table (recommended). If this option is selected, KiCad will copy
the default symbol library table file stored in the system’s Kicad template folder to the file sym-lib-
table  in the user’s KiCad configuration folder. If the default template sym-lib-table  file cannot be
found, this option will be grayed out. The missing default table is usually caused by the KiCad default
libraries not being installed (on some systems they are installed by a separate package). If the libraries
are installed in a non-standard location, use the second option and browse to the library table location
manually.

Copy custom global symbol library table. If this option is selected, the user must browse to the desired
symbol library table file, which will be copied to the user’s KiCad configuration directory.

Create an empty global symbol library table. An empty symbol library table file will be created in the
user’s KiCad configuration directory. The user must add libraries to the table manually.
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NOTE

デフォルトのシンボル・ライブラリー・テーブルは、KiCad の一部としてインストールされる
標準のシンボル・ライブラリーを全て含んでいます。システムの実行速度と使用状況に依存す
ることは、望ましいこととは限りません。シンボル・ライブラリーの読み込みに必要な時間
は、シンボル・ライブラリー・テーブルにあるライブラリーの数に比例します。もしシンボ
ル・ライブラリーの読み込み時間が長すぎるなら、グローバル・ライブラリー・テーブルから
全く使わない、あるいは滅多に使わないライブラリーを削除し、必要に応じてプロジェクト・
ライブラリー・テーブルに削除したライブラリーを追加して下さい。

テーブル要素の追加
シンボル・ライブラリーを使うには、まず最初にグローバル・テーブルかプロジェクト固有のテーブルを追加しな
ければなりません。プロジェクト固有のテーブルは、プロジェクト・ファイルが開かれた時のみ有効です。

NOTE Each library entry must have a unique nickname.

The library nickname does not have to be related in any way to the actual library file name or path. The
colon :  and \  characters cannot be used anywhere in the library nickname. Each library entry must have a
valid path and/or file name depending on the type of library. Paths can be defined as absolute, relative, or by
environment variable substitution (see section below).

The appropriate library format must be selected in order for the library to be properly read. "KiCad" format
is used for KiCad version 6 libraries ( .kicad_sym  files), while "Legacy" format is used for libraries from
older versions of KiCad ( .lib  files). Legacy libraries are read-only, but can be migrated to KiCad format
libraries using the Migrate Libraries button (see section Migrating Legacy Libraries).

説明フィールドは、ライブラリー・エントリーの説明を追加するためのものです。オプション・フィールドは現在
のところ使われておらず、追加されたオプションはライブラリーがロードされても何も影響を与えません。

同じテーブルには重複したライブラリーのニックネームを持つことが出来ないことに注意して下さい。しかし
ながら、グローバルとプロジェクト固有のライブラリー・テーブルの両方で重複したライブラリーのニックネ
ームを持つことは可能です。

もし名前の衝突が起こった場合、プロジェクト固有のテーブル・エントリーがグローバル・テーブル・エント
リーに優先します。

エントリーがプロジェクト固有のテーブルに定義されている場合、エントリーを含んだ sym-lib-table は現在
開かれているプロジェクト・ファイルのあるフォルダーに書き込まれます。

環境変数の代替
One of the most powerful features of the symbol library table is environment variable substitution. This
allows for definition of custom paths to where symbol libraries are stored in environment variables.
Environment variable substitution is supported by using the syntax ${ENV_VAR_NAME}  in the library path.

By default, at run time KiCad defines two environment variables relevant for locating symbol libraries:

the $KIPRJMOD  environment variable that always points to the currently open project directory.
$KIPRJMOD  cannot be modified.

the $KICAD6_SYMBOL_DIR  environment variable. This points to the path where the default symbol
libraries that were installed with KiCad.
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You can override $KICAD6_SYMBOL_DIR  by redefining it in Preferences → Configure Paths… . This is useful
for using libraries installed in a nonstandard location.

$KIPRJMOD  allows you to store libraries in the project path without having to define the absolute path
(which is not always known) to the library in the project specific symbol library table.

使用パターン
Symbol libraries can be defined either globally or specifically to the currently loaded project. Symbol
libraries defined in the user’s global table are always available and are stored in the sym-lib-table  file in
the user’s KiCad configuration folder. The project-specific symbol library table is active only for the
currently open project file.

各方法には長所と短所があります。全てのライブラリーをグローバル・テーブルに定義すると、必要な時にいつで
も使うことができます。これの短所は、読み込み時間が長くなることです。

全てのシンボル・ライブラリーをプロジェクト固有のテーブルへ定義すると、プロジェクトが必要とするライブラ
リーだけとなるので、シンボル・ライブラリーの読み込み時間が短くて済みます。これの短所は、プロジェクトご
とに必要とされるシンボル・ライブラリーをそれぞれ忘れずに追加しなければならないことです。

使用パターンの一つは、よく使うライブラリーをグローバル、そのプロジェクトでのみ必要とされるライブラリー
はプロジェクト固有のライブラリー・テーブルに定義することでしょう。ライブラリーを定義するにあたっての制
約は特にありません。

Migrating Legacy Libraries
Legacy libraries ( .lib  files) are read-only, but they can be migrated to KiCad version 6 libraries
( .kicad_sym ). KiCad version 6 libraries cannot be viewed or edited by KiCad versions older than 6.0.0.

Legacy libraries can be converted to KiCad 6 libraries by selecting them in the symbol library table and
clicking the Migrate Libraries button. Multiple libraries can be selected and migrated at once by -
clicking or -clicking.

Libraries can also be converted one at a time by opening them in the Symbol Editor and saving them as a
new library.

以前のプロジェクトのリマッピング
When loading a schematic created prior to the symbol library table implementation, KiCad will attempt to
remap the symbol library links in the schematic to the appropriate library table symbols. The success of this
process is dependent on several factors:

回路図で使われているオリジナルのライブラリーがまだ有効であり、シンボルが回路図に追加された時から変
更されていない。

レスキュー・ライブラリーを作成するか、既存のレスキュー・ライブラリーを最新に保っていることを確認し
たときに、全てのレスキュー動作が実行されている。

プロジェクトのシンボル・キャッシュ・ライブラリーが完全な状態のままで、破損していない。

WARNING
リマッピングでは、プロジェクト・フォルダーにあるレスキュー・バックアップ・フォルダー
の中にリマッピング中に変更された全てのファイルをバックアップします。何か問題が起きた
時に備えて、リマッピングの前には常にプロジェクトをバックアップして下さい。

Ctrl

shift
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WARNING
適切なシンボルをリマッピングで得ることを保証するために無効化されていたとしても、レス
キュー動作は実行されます。この動作をキャンセルしてはいけません。さもないと、リマッピ
ング動作は、回路図のシンボルを正しくリマップすることに失敗します。

NOTE

If the original libraries have been removed and the rescue was not performed, the cache
library can be used as a recovery library as a last resort. Copy the cache library to a new
file name and add the new library file to the top of the library list using a version of KiCad
prior to the symbol library table implementation.
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回路図の作成と編集
はじめに
回路図は１枚のシートのみを使用しても作成可能ですが、規模の大きな回路図の場合は複数のシートで構成するこ
ともできます。

A schematic represented by several sheets is hierarchical, and all its sheets (each one represented by its own
file) constitute a complete KiCad schematic. The manipulation of hierarchical schematics will be described in
the Hierarchical Schematics chapter.

基本的な検討事項
A schematic designed with KiCad is more than a simple graphic representation of an electronic device. It is
normally the entry point of a development chain that allows for:

回路図の誤りや欠落の検出。 (ERC（エレクトリカル・ルール・チェック）による設計検証)

部品表（BOM： Bill Of Material）の自動生成。 (カスタマイズされたネットリストとBOM （部品表）ファイ
ルの生成)

Pspice などの回路シミュレータのためのネットリスト生成。 カスタマイズされたネットリストとBOM （部品
表）ファイルの生成

Defining a circuit for transferring to PCB layout.

回路図は主にシンボル、ワイヤー、ラベル、ジャンクション、バス、電源から構成されます。また回路図を見易く
するために、バスエントリー、コメント、破線などのグラフィック要素も配置できます。

Symbols are added to the schematic from symbol libraries. After the schematic is made, the set of
connections and footprints is imported into the PCB editor for designing a board.

シンボルの配置と編集

シンボルの検索と配置
To load a symbol into your schematic you can use the icon . A dialog box allows you to type the name of

the symbol to load.
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“シンボルの選択” ダイアログは、名前、キーワード、検索フィールドへの入力内容でシンボルをフィルターリング
できます。以下の入力により、アドバンスト フィルターを使用することが可能です:

ワイルドカード: 文字 ?  と *  を使用します。これらは "任意の 一文字" と "長さ0以上の任意の文字列" を意味
します。

関係型: ライブラリーの部品の説明またはキーワードがフォーマット "Key:123" のタグを 含んでいる場
合、"Key>123" (以上)、"Key<123" (以下) 等のように入力することで、それに応じて 一致させることができま
す。数字は以下の大文字・小文字を区別しない 接尾辞の何れかを含めることができます:

p n u m k meg g t

10 10 10 10 10 10 10 10

ki mi gi ti

2 2 2 2

正規表現: もし正規表現に精通しているのであれば、これらを 使うこともできます。使用されている正規表現
のタイプは wxWidgets Advanced Regular Expression style で、Perl の正規表現 と似たような形式です。

If the symbol specifies a default footprint, this footprint will be previewed in the lower right. If the symbol
includes footprint filters, alternate footprints that satisfy the footprint filters can be selected in the
footprint dropdown menu at right.

After selecting a symbol to place, the symbol will be attached to the cursor. Left clicking the desired location
in the schematic places the symbol into the schematic. Before placing the symbol in the schematic, you can
rotate it, mirror it, and edit its fields, by either using the hotkeys or the right-click context menu. These
actions can also be performed after placement.

配置中のシンボルは次のようになります :

-12 -9 -6 -3 3 6 9 12

10 20 30 40

http://docs.wxwidgets.org/3.0/overview_resyntax.html
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If the "Place repeated copies" option is checked, after placing a symbol KiCad will start placing another copy
of the symbol. This process continues until the user presses .

For symbols with multiple units, if the "Place all units" option is checked, after placing the symbol KiCad will
start placing the next unit in the symbol. This continues until the last unit has been placed or the user
presses .

Placing power ports
A power port symbol is a symbol representing a connection to a power net. The symbols are grouped in the
power  library, so they can be placed using the symbol chooser. However, as power placements are frequent,

the  tool is available. This tool is similar, except that the search is done directly in the power  library.

（配置された）シンボルの編集と変更
シンボルの編集には，以下の２種類があります:

シンボル自身の変更：部品の位置、向き、複数ユニットを持つシンボルのユニット選択。

シンボルフィールドの変更：リファレンス、定数、フットプリント、等。

シンボルを配置したら、それらの部品定数を変更できます（特に抵抗やコンデンサなど）。しかし、（シンボルを
ユニットで固定したい場合は、手動でリファレンスを割り当てる必要がありますが、）配置したシンボルへのリフ
ァレンスの割り当てやユニットの選択は、必ずしも必要なことではありません。なぜなら、これらシンボルのリフ
ァレンスや部品番号は、アノテーション機能を使うことで後から自動的に割り振ることができるからです。

シンボルの変更
シンボルの設定を編集するには、マウスカーソルをシンボル上へ移動させ、以下のいずれかの操作をします。:

シンボルをダブルクリックして、全ての設定を編集できるダイアログを開く。

右クリックしてコンテキストメニューを開き、表示された編集コマンドを選択する: 移動、回転、編集、削除な
ど。

Esc

Esc
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Use a hotkey to perform an action on the symbol (  to open the properties dialog,  to rotate, etc.).
Note that hotkeys act on the selected symbol; if no symbol is selected hotkeys act on the symbol under
the cursor.

Symbols can also be selected by clicking on them or drag-selecting them. Selected symbols can be modified
by clicking relevant buttons in the top toolbar or using a hotkey.

テキストフィールドの編集
リファレンス、定数、位置、向き、テキストサイズ、フィールドの可視性を変更できます。:

テキストフィールドをダブルクリックし編集する。

右クリックしてコンテキストメニューを開き、表示された編集コマンドを選択する: 移動、回転、編集、削除な
ど。

Position the cursor over the field (if nothing is selected) or select the field and press  to edit the field.

Position the cursor over the symbol (if nothing is selected) or select the symbol and press , , or 
hotkeys to directly edit the symbol’s value, reference designator, or footprint fields, respectively.

他のオプションの変更や新たにフィールド項目を作成する場合は、シンボルをダブルクリックし、シンボルシンボ
ル プロパティのダイアログを開きます。

それぞれのフィールドについて表示/非表示と回転（表示方向）を設定することができます。表示位置は常に普通
に表示される（回転やミラーがない）シンボルに対するもので、シンボルのアンカー位置への相対座標で指定しま
す。

The position and orientation properties of each field may be hidden in this dialog. They can be shown by
right-clicking on the column header of the fields table and enabling the "Orientation", "X Position", and/or "Y
Position" columns. Other columns can be shown or hidden as desired.

The "Update Symbol from Library… " button is used to update the schematic’s copy of the symbol to match
the copy in the library. The "Change Symbol… " button is used to swap the current symbol to a different

E R

E

V U F
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symbol in the library.

"Edit Symbol… " opens the Symbol Editor to edit the copy of the symbol in the schematic. Note that the
original symbol in the library will not be modified. The "Edit Library Symbol… " button opens the Symbol
Editor to edit the original symbol in the library. In this case, the symbol in the schematic will not be modified
until the user clicks the "Update Symbol from Library… " button.

Electrical Connections

はじめに
There are a number of elements that can be added to a schematic to electrically connect components. All of
these elements can be placed with the buttons on the vertical right toolbar or using hotkeys.

これらの要素を以下に示します:

Wires: direct connection between pins.

Buses: connections for a group of signals.

Bus entries: connections between wires and buses.

No-connection flags: terminations for pins or wires that are intentionally unconnected. These flags
prevent ERC violations for unconnected pins.

Junctions: connections between crossing wires or buses.

Net labels: local name for a signal. Signals within a sheet that have the same net label are connected.

Global labels: global name for a signal. Signals with the same global label are connected even if they are
not in the same sheet.

Hierarchical labels: a label for a signal in a subsheet that enables the signal to be accessed in a parent
sheet. See the Hierarchical Schematics section for more information about hierarchical labels, sheets, and
pins.

Hierarchical sheets: an instantiation of a subsheet within a parent sheet. The parent sheet can connect
to the subsheet through the subsheet’s hierarchical pins.

Hierarchical pins: connection points between a parent sheet and a subsheet. Hierarchical pins appear at
the parent sheet’s level and correspond to hierarchical labels in the subsheet.

Several other types of items can be placed on the schematic but do not affect connectivity:

Graphical lines: graphical lines for presentation.

Text: textual comments and annotations.

Bitmap images: raster graphics from an external file.

This section will also discuss two special types of symbols that can be added with the "Power port" button on
the right toolbar:

Power ports: symbols for connecting wires to a power or ground net.

PWR_FLAG: a specific symbol for indicating that a net is powered when it is not connected to a power
output pin (for example, a power net that is supplied by an off-board connector).
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接続 (ワイヤーとラベル)
接続を確立する方法は2つあります:

ピン間のワイヤー

ラベル

以下の図はこれら2種類の接続方法を示します。

Label Connections
The point of "contact" of a label is the small square in the corner of the label. The square disappears when
the label is connected. The position of the connection point relative to the label text can be changed by
choosing a different label orientation in the label properties, or by mirroring/rotating the label.

The label’s connection point must be in contact with a wire or the end of a pin for the label to be connected.

Wire Connections
接続を確立するためには、ワイヤーの端を他のセグメントかピンへ接続します。

もし配線とピンが重なりあった場合（ピンの終端へ接続されずにワイヤーがピンを乗り越えた場合）、これらは接
続されません。

NOTE

Wires connect with other wires or pins only if their ends coincide exactly. Therefore it is
important to keep symbol pins and wires aligned to the grid. It is recommended to always
use a 50 mil grid when placing symbols and drawing wires because the KiCad standard
symbol library and all libraries that follow its style also use a 50 mil grid.
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NOTE Symbols, wires, and other elements that are not aligned to the grid can be snapped back to
the grid by selecting them, right clicking, and selecting Align Elements to Grid.

Wire Junctions
Wires that cross are not implicitly connected. It is necessary to join them with a junction dot if a connection
is desired. Junction dots will be automatically added to wires that start or end on top of an existing wire.

Junction dots are used in the previous figure on the wires connected to P1  pins 18, 19, 20, 21, 22, and 23.

Nets with Multiple Names
A signal can only have one name. If two different labels are placed on the same net, an ERC violation will be
generated. Only one of the net names will be used in the netlist.

Hidden Power Pins
When the power pins of a symbol are visible, they must be connected, as with any other signal.

However, symbols such as gates and flip-flops are sometimes drawn with hidden power input pins which are
connected implicitly.

KiCad automatically connects invisible pins with type "power input" to a global net with the same name as
the pin. For example, if a symbol has a hidden power input pin named VCC , this pin will automatically be
connected to the global VCC  net.

NOTE

Care must be taken with hidden power input pins because they can create unintentional
connections. By nature, hidden pins are invisible and do not display their pin name. This
makes it easy to accidentally connect two power pins to the same net. For this reason, the
use of invisible power pins in symbols is not recommended outside of power port
symbols, and is only supported for compatibility with legacy designs and symbols.

NOTE
Hidden pins can be shown in the schematic by checking the Show hidden pins option in
the Schematic Editor → Display Options section of the preferences, or by selecting View
→ Show hidden pins. There is also a toggle icon  on the left (options) toolbar.

It may be necessary to join power nets of different names (for example, GND  in TTL components and VSS  in
MOS components). To accomplish this, add a power port symbol for each net and connect them with a wire.

It is not recommended to use labels for power connection. These only have a "local" connection scope, and
will not connect to invisible power pins.

Wiring
To begin connecting elements, you may either use the 'Wire' or 'Bus' tools from the right-hand toolbar, or
you can auto-start a new wire from any existing pin or unconnected wire.

The wire drag action will drag the entire wire if you start dragging from the middle of the wire.
Alternatively, it will drag just one corner if you start the drag action over a corner where two wires connect

バスの接続
以下に示す回路図では、多くのピンがバスへ接続されています。
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バスのメンバー
バスは、複雑な設計を単純に図示するために回路図上での関連した信号をグループ化したものです。バスは、バス
ツールを使って配線のように描くことができ、信号線と同様にラベルを使って名前を付けることができます。
KiCad 6.0 以降では、バスのタイプが２つあります。ベクトル バスとグループ バスです。

*ベクトル バス* は共通の接頭辞で始まり数字で終わる信号のコレクションです。 ベクトル バスは `<PREFIX>[M..N]` と
名前が付けられ、ここで `PREFIX` は有効な信号名、 `M` は接尾辞で使われる最初の番号、 `N` は接尾辞で使われる最後
の番号です。 例えば、バス `DATA[0..7]` は信号 `DATA0`, `DATA1`, … `DATA7` から構成されます。 指定される 
`M` と `N` は降順でも昇順でも構いませんが、ともに正の整数でなければなりません。

*グループ バス* は一つ以上の信号またはベルトル バスのコレクションです。 グループ バスは、異なった名前を持っていた
としても関連した信号をまとめてバンドルするために使うことができます。 グループ バスには特別なラベルの文法を使用しま
す:

<OPTIONAL_NAME>{SIGNAL1 SIGNAL2 SIGNAL3}

グループのメンバーは、中括弧 ( {} ) 内に空白文字で区切られて列挙されます。 任意で付けられるグループ名は、
中括弧の前に置かれます。 グループ バスに名前がない場合、基板のネットはグループ内の信号名だけとなりま
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す。 グループ バスが名前を持っている場合、ネットでは信号名からピリオド ( . ) で区切られた接頭辞として名前
を持ちます。

例えば、バス {SCL SDA}  は２つの信号のメンバーを持っており、ネットリスト内でのこれらの信号は SCL  と
SDA  です。 バス USB1{DP DM}  は USB1.DP  と USB1.DM  と呼ばれるネットを生成します。 いくつかの同じような
回路に渡って繰り返し使われる多くの信号を持つバスを使った設計では、この技法を使うことで時間を節約できま
す。

グループ バスは、ベクトル バスを含むこともできます。 例えば、バス MEMORY{A[7..0] D[7..0] OE WE}  はベク
トル バスと普通の信号を含んでおり、基板上のネットでは MEMORY.A7  と MEMORY.OE  のようになります。

Bus wires can be drawn and connected in the same manner as signal wires, including using junctions to
create connections between crossing wires. Like signals, buses cannot have more than one name — if two
conflicting labels are attached to the same bus, an ERC violation will be generated.

バス メンバー同士の接続
Pins connected between the same members of a bus must be connected by labels. It is not possible to
connect a pin directly to a bus; this type of connection will be ignored by KiCad.

上に示したような例では、ピンに接続しているワイヤーへ配置されたラベルによってピン間が接続されます。バス
ワイヤーへのバスエントリー部（ 45 度曲がっているワイヤー部分）は外観上の見易さを目的としているだけで、
Eeschema で回路図としての意味はありません。（論理的な接続である必要はありません）

In fact, using the repetition command ( ), connections can be very quickly made in the following way,
if component pins are aligned in increasing order (a common case in practice on components such as
memories, microprocessors… ):

Place the first label (for example PCA0 )

Use the repetition command as much as needed to place members. KiCad will automatically create the
next labels ( PCA1 , PCA2… ) vertically aligned, theoretically on the position of the other pins.

最初のラベルの下にワイヤーを配置します。同様に繰り返しコマンドを利用し、ラベルの下へワイヤーを配置
していきます。

必要に応じて、同じ方法（最初のエントリーを配置し，繰り返しコマンドを使用する）を用い、バスエントリ
ーを配置して下さい。

NOTE

In the Schematic Editor → Editing Options section of the Preferences menu, you can set
the repetition parameters:

Horizontal pitch.

Vertical pitch.

Label increment (labels can be incremented or decremented by 1, 2, 3, etc.).

バスの展開
The unfold tool allows you to quickly break out signals from a bus. To unfold a signal, right-click on a bus
object (a bus wire, etc) and choose Unfold from Bus. Alternatively, use the Unfold Bus hotkey (default: )
when the cursor is over a bus object. The menu allows you to select which bus member to unfold.

Insert

C
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バスのメンバーを選択後、次のクリックで希望する場所にバス メンバーのラベルを配置します。 ツールは自動的
にバス エントリーを生成し、ラベル位置からの配線を可能にします。ラベルを配置した後、続けて配線を追加 (例
えば、部品のピンに接続) して、通常の方法を使って結線を完了できます。

バス エイリアス
バス エイリアスは、大きなグループ バスでの作業をより効率的にするショートカットです。 これらはグループ バ
スを定義して、回路図全体における完全なグループ名に代わって使うことができるショートカット名を与えます。

To create bus aliases, open the Bus Definitions dialog in the Tools menu.

エイリアスには、有効な信号名なら何を付けても構いません。 ダイアログを使って、信号あるいはベクトル バス
をエイリアスに追加することができます。 ショートカットとして、空白文字で区切られた信号やバスのリストに
入力あるいは貼り付けでき、それらは全て、エイリアス定義に追加されます。 この例では、メンバー DP , DM ,
VBUS  を持つ USB  と呼ばれるエイリアスを定義します。

エイリアスを定義した後、 グループ バス: {USB}  の中括弧内にエイリアス名を置くことによってグループ バス ラ
ベルで使うことができます。 これはバス {DP DM VBUS}  のラベルと同等の効果を持ちます。. USB1{USB}  のよう
に、グループに接頭辞の名前を追加することもでき、上に書かれた USB1.DP  のようなネットとなります。 複雑な
バスでは、エイリアスの使用によって回路図上のラベルをより短くすることができます。 エイリアスは単なるシ
ョートカットであり、ネットリスト中にはエイリアス名が含まれないことを覚えておいて下さい。

バスのエイリアスは回路図ファイル中に保存されます。 与えられた回路図シートで作られたエイリアスは、同じ
階層設計における他の回路図シートで全て使用することができます。
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複数のラベルを持つバス
KiCad 5.0 および以前のバージョンでは、互いに異なったラベルを持つバス配線の接続が許容されており、ネット
リスト中でそれらのバスのメンバーを結合していました。このような挙動は、グループ バスに適合せず、与えら
れた信号が受け取る名前を簡単に予見できないことでネットリストの混乱を引き起こすため、KiCad 6.0 では削除
されています。

この機能が使用されている設計を新しいバージョンの KiCad で開いた場合、与えられたバス配線のセットには単
一のラベルのみが存在するように回路図を更新するためのバス移行ダイアログが表示されます。

一つ以上のラベルを持つバス配線のセットごとに、保持したいラベルを選択しなければなりません。 ドロップダ
ウン名前ボックスを使って回路図に存在する既存のラベルから選択するか、新しい名前フィールドへの入力によっ
て別の名前を選択できます。

Power Ports
Power port symbols are conventionally used to connect pins to power nets. Power port symbols have a
single pin which is invisible and marked as a power input. As described in the hidden power pins section, any
wire connected to the pin of a power port is therefore automatically connected to the power net with the
same name as the port’s pin.

In the KiCad standard library, power ports are found in the power  library, but power port symbols can be
created in any library. To create a custom power port, make a new symbol with a hidden pin marked as a
power input. Name the pin according to the desired power net.

以下の図は、電源ポートの接続例です。
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In this example, power ports symbols are used to connect the positive and negative terminals of the
capacitors to the VCC  and GND  nets, respectively.

Power port symbols are found in the power  symbol library. They can also be created by drawing a symbol
with a hidden "power input" pin that has the name of the desired power net.

PWR_FLAG
Two PWR_FLAG  symbols are visible in the screenshot above. They indicate to ERC that the two power nets
VCC  and GND  are actually connected to a power source, as there is no explicit power source such as a
voltage regulator output attached to either net.

Without these two flags, the ERC tool would diagnose: Error: Input Power pin not driven by any Output
Power pins.

The PWR_FLAG  symbol is found in the power  symbol library. The same effect can be achieved by connecting
any "Power Output" pin to the net.

No-connection flag
No-connection flags ( ) are used to indicate that a pin is intentionally unconnected. These flags do not

have any effect on the schematic’s connectivity, but they prevent "unconnected pin" ERC warnings for pins
that are intentionally unconnected.

回路図作成に関する補足

Text comments and graphic lines
It can be useful to place annotations such as text fields and frames to aid in understanding the schematic.
Text fields ( ) and graphic lines ( ) are intended for this use, as opposed to labels and wires, which are

connection elements.

The image below shows graphic lines and text in addition to wires, local labels, and hierarchical labels.

シートの表題欄（タイトルブロック）
The title block is edited with the Page Settings tool ( ).
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Each field in the title block can be edited, as well as the paper size and orientation. If the "Export to other
sheets" option is checked for a field, that field will be updated in the title block of all sheets, rather than only
the current sheet.

A drawing sheet template file can also be selected.

The sheet number (Sheet X/Y) is automatically updated, but sheet page numbers can also be manually set
using Edit → Edit Sheet Page Number… .

キャッシュされたシンボルのレスキュー
By default, KiCad loads symbols from the project libraries according to the set paths and library order. This
can cause a problem when loading a very old project: if the symbols in the library have changed or have
been removed or the library no longer exists since they were used in the project, the ones in the project
would be automatically replaced with the new versions. The new versions might not line up correctly or
might be oriented differently leading to a broken schematic.

When a project is saved, a cache library with the contents of the current library symbols is saved along with
the schematic. This allows the project to be distributed without the full libraries. If you load a project where
symbols are present both in its cache and in the system libraries, KiCad will scan the libraries for conflicts.
Any conflicts found will be listed in the following dialog:
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この例では、元々のプロジェクトはカソードが上向きのダイオードを使っていますが、現在のライブラリーはカソ
ードが下向きのものを含んでいます。この変更はプロジェクトを台無しにします！ここで OK ボタンを押すと、古
いシンボルは特別な “レスキュー” ライブラリーへと保存され、全てのシンボルは名前の衝突を避けるために変更
(rename) されます。

If you press Cancel, no rescues will be made, so KiCad will load all the new components by default. If you
save the schematic at this point, your cache will be overwritten and the old symbols will not be recoverable.
If you have saved the schematic, you can still go back and run the rescue function again by selecting "Rescue
Cached Components" in the "Tools" menu to call up the rescue dialog again.

このダイアログを表示させたくない場合は、“次回から表示しない” ボタンを押してください。デフォルトで何もせ
ずに新しいシンボルを読み込むようになります。このオプションは、ライブラリーの設定で元に戻せます。
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階層回路図
はじめに
シート数が２～３枚で済まないようなプロジェクトでは、階層的表現を用いるのが一般的によい解決策となりま
す。この種のプロジェクトを管理したい場合、次のことが必要になるでしょう:

大きなサイズのシートを使用する。その場合、印刷と取り扱いの問題が生じます。

シートを数枚使用する。これは階層構造に至ります。

完全な回路図は、ルートシートと呼ばれるメインの回路図シートおよび階層を構成するサブシートから構成されま
す。さらに、設計を個別のシートにうまく分割すると可読性が改善されます。

From the root sheet, you must be able to find all sub-sheets. Hierarchical schematics management is very

easy with KiCad, thanks to an integrated "hierarchy navigator" accessible via the icon  of the top toolbar.

階層には２種類が同時に存在し得ます：１つ目は、すでに開いて使用しているような一般的に使用されているもの
です。２つ目は、回路図で使われるシンボルの実体を表すもので、実際にはシンボルの内部構造を記述した回路図
に対応します。

この２つ目のタイプはよく集積回路 (IC) の開発で使用されます。この場合には作成中の回路図で機能ライブラリ
ーを使用しなければならないからです。

KiCad currently doesn’t treat this second case.

階層は次のようなものです:

単一： 任意のシートを一度だけ使用する。

複合： 任意のシートを２回以上使用する（複数のインスタンス）。

平面 (Flat) ： 単一の階層であるが、シート間の接続は記述されない。

KiCad can deal with all these hierarchies.

階層回路図の作成は簡単です。階層全体はルート回路図から始まるように管理され、ただ一つの回路図しかないよ
うに見えます。

次の２つの重要なステップを理解する必要があります：

サブシートの作成方法。

サブシート間の電気的な接続方法。

階層内のナビゲーション
Navigation among sub-sheets is acheived by using the navigator tool accessible via the button  on the

top toolbar.
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シート名をクリックすると、そのシートに移動できます。シート名を右クリックして "シートに入る" を選択する
か、境界線をダブルクリックしても、シートに移動できます。

現在のシートから抜けて親のシートに移動するには、回路図の何もオブジェクトが無いところで右クリックして
"シートから抜ける" を選択するか、 Alt + Backspace を入力します。

ローカルラベル、階層ラベル、グローバルラベル
プロパティ
Local labels, tool , are connecting signals only within a sheet. Hierarchical labels (tool ) are

connecting signals only within a sheet and to a hierarchical pin placed in the parent sheet.

Global labels (tool ) are connecting signals across all the hierarchy. Power pins (type power in and power

out) invisible are like global labels because they are seen as connected between them across all the
hierarchy.

NOTE （単一または複合）階層内では、階層ラベルとグローバルラベルのどちらか、または両方を使
用可能です。

階層作成の要約
次のことをする必要があります:

“シートシンボル” という階層シンボルをルートシート内に配置します。

ナビゲーターを使用して新規回路図（サブシート）に入り、他の回路図と同様に作成します。

新しく作成した回路図（サブシート）にグローバルラベル (HLabels) を配置して２つの回路図間に電気的接続
を作成します。また、シートラベル (SheetLabels) という同じ名前を持つラベルをルートシートに配置しま
す。これらのシートラベルはルートシートのシートシンボルや標準的なコンポーネントピンのような他の回路
図要素に接続されます。

シートシンボル
対角上の２点を指定して作成した矩形でサブシートを表します。

この矩形のサイズは、サブシート内のグローバルラベル (HLabels) に対応した特定のラベルや階層ピンを後で配置
可能なものでなければなりません。これらのラベルは通常のコンポーネントピンに似ています。

These labels are similar to usual symbol pins. Select the tool .

左クリックして矩形の左上角を配置します。矩形が十分な大きさとなったら再度左クリックして右下角を配置しま
す。

この時、（階層ナビゲーターを使用し、対応する回路図に移動するために）このサブシートのファイル名とシート
名の入力が要求されます。
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少なくともファイル名の入力が必要です。シート名がない場合、ファイル名がシート名として使用されます（この
方法はよく行われています）。

接続 － 階層ピン
作成したシンボル用の接続点（階層ピン）をここで作成します。

これらの接続点は通常のシンボルのピンに似ていますが、１つの接続点だけで複数の信号からなるバスを接続でき
ます。

Importing Hierarchical Sheet Pins
Select the tool .

Click on the hierarchical sheet from where you want to import the pins corresponding to hierarchical
labels placed in the corresponding schematic. A hierarchical pin appears, if a new hierarchical label
exists, i.e. not corresponding to an already placed pin.

このピンを配置したい場所でクリックします。

All necessary pins can thus be placed quickly and without error. Their aspect is in accordance with
corresponding hierarchical labels.

接続 - 階層ラベル
Each pin of the sheet symbol just created, must correspond to a label called hierarchical Label in the sub-
sheet. Hierarchical labels are similar to labels, but they provide connections between sub-sheet and root
sheet. The graphical representation of the two complementary labels (pin and hierarchical labels) is similar.
Hierarchical labels are made with the tool .

以下はルートシートの例です。
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ピン VCC_PIC がコネクタ JP1 に接続されていることに注意して下さい。

サブシート内での対応する接続は次のようになります :

２つの階層シート間を接続する２つの対応する階層ラベルがあるのがさらにわかります。

NOTE 既述の構文 (Bus [N. .m]) に従って、２つのバスを接続する階層ラベルおよび階層ピンを使うこ
とが可能です。

（単純な）ラベル、階層ラベル、グローバルラベル、非表示電源ピン
ワイヤーによる接続以外に、接続を行う様々な方法について説明します。
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（単純な）ラベル
単純なラベルはローカルな接続に使います。つまり、接続は配置されている回路図シートだけ制限されます。これ
は次の理由によります :

各シートにはシート番号が存在する。

このシート番号はラベルに関連付けられる。

そのため、シート番号３にラベル “TOTO” を配置した場合、実際のラベルは “TOTO_3” となります。シート番号
１（ルートシート）にラベル “TOTO” を 配置した場合、実際には “TOTO_3” ではなく “TOTO_1” というラベルを
配置したことになります。これはシートが１つしかない場合でも常にこうなります。

階層ラベル
単純なラベルで言えることは、階層ラベルにも当てはまります。

このため、同一シート内で階層ラベルの “TOTO” はローカルラベル “TOTO” に接続されていると見なされます
が、別のシートの 階層ラベルあるいは “TOTO” というラベルには接続されません。

階層ラベルはルートシートに配置された階層シンボル内の対応するシートのシンボルのピンに接続されていると見
なされます。

非表示電源ピン
非表示の電源ピンは、同一名であるなら互いに接続されているものと見なされます。このため、“非表示の電源ピ
ン“ として宣言されている VCC という名前の電源ピンは、それが置かれているシートにある VCC という名前の全
てのピンに接続されます。

このことは，あるサブシートに VCC ラベルを配置した場合、そのラベルが VCC ピンには接続されないということ
を意味します。それは、このラベルが実際には VCC_n であるからです。ここで n とはシート番号です。

この VCC ラベルを回路図全体の VCC 接続したいなら、VCC 電源シンボルによって明示的に非表示電源ピンへ接続
する必要があります。

グローバルラベル
同一名のグローバルラベルは、全ての階層に渡って互いに接続されています。

（vcc …  のような電源ラベルはグローバルラベルです）

複合階層
一例を示します。同じ回路図が２回使用されています（２つのインスタンス）。２つのシートのファイル名が同じ
なので (“other_sheet.sch”) 、２つのシートは同じ回路図を共有します。シート名は固有でなければなりません。
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平面階層
シート間の接続を作らずに（平面階層 (flat hierarchy) ）、シートを多数使うプロジェクトの作成が可能です。そ
れには下記のルールを順守して下さい:

ルートシートを作成し、他のすべてのシートをそれに含めます。ルートシートはシート間のリンクとして機能
します。

明示的な接続はまったく必要ありません。

全てのシート間の接続には、階層ラベルではなくグローバルラベルを使用します。

ルートシートの例を以下に示します。
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２ページあり、それらはグローバルラベルで接続されています。

こちらが pic_programmer.sch です。

こちらが pic_sockets.sch です。
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グローバルラベルに注目してください。
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シンボル アノテーション ツール
はじめに
The annotation tool allows you to automatically assign a designator to symbols in your schematic.
Annotation of symbols with multiple units will assign a unique suffix to minimize the number of these

symbols. The annotation tool is accessible via the icon . Here you find its main window.

アノテーション方法一覧 :

全てのシンボルをアノテート（「既存のアノテーションをリセット ® 」を選択）。

既存の複数ユニットをシンボルの順番を入れ替えないで、全てのシンボルをアノテート（「既存のアノテーシ
ョンをリセット、ただし複数ユニットを持つ部品はキープ（Ｅ）」を選択）。

アノテートされていないシンボルだけアノテート。 "?" で終わるリファレンス（参照番号）を持つシンボルが
対象です。

全階層をアノテート （「全ての回路図，階層を使用 (E) 」を選択）。

現在のシートのみをアノテート （「現在のページのみ使用 (Ｐ) 」を選択）。

''既存のアノテーションをリセット、ただし複数ユニットを持つ部品はキープ''オプションは、複数ユニットを持つ
シンボルの全ての関連性を保存します。これは、もし U2A と U2B があったなら、それぞれ U1A と U1B へと番号
が振られることはあっても、 U1A と U2A、または U2B と U2A とはならないということです。これは、ピングル
ープを確実に維持したい時、配置するのに都合がいいように定義した子部品がある時、に役立ちます。

「アノテーションの順番」オプションでは、それぞれのシート内での番号の振り方を指定することができます。

特別な場合を除いて、以前のアノテーション結果を変更しない場合は、プロジェクト全体（全てのシート）と新し
いコンポーネントが自動アノテーションの対象となります。

「アノテーションの選択」オプションでは、リファレンス（参照番号）の計算方法を指定します。:

回路図中の最初の空き番号から使用する：コンポーネントは (各リファレンス接頭辞につき) １からリファレン
ス番号が振られます。前回のアノテーションをキープする場合は、使われていない番号から利用されます。
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シートの Ref 番号を *100 から開始し、最初の空き番号から使用する：シート１では 101 から，シート２では
201 からリファレンス番号が振られます。それぞれのリファレンス接頭辞 (ＵやＲ) が１シート内で 99 を超え
てしまった場合は継続して以降の番号が振られ、例えばシート２では 200 番台の最初の空き番号から リファレ
ンス番号が振られます。

シートの Ref 番号を *1000 から開始し、最初の空き番号から使用する：シート１では 1001 からリファレンス
が振られ、シート２では 2001 からリファレンスが振られていきます。

例
アノテーションの順序
部品配置後、未だリファレンスが振られていない５つの素子を例とします。

アノテーションを実行すると、以下のような結果が得られます。

コンポーネントをＸ位置でソートした場合：

コンポーネントをＹ位置でソートした場合。
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アノテーションにより、74LS00 の４つのゲートが U1 パッケージにまとめられ、５番目のゲートは次の U2 へと分
類されました。

アノテーションの選択
下記の図は、部品をシート２に配置し、「回路図中の最初の空き番号から使用する」オプションを利用してアノテ
ーションを行ったものです。

「シートの Ref 番号を*100 から開始し、最初の空き番号から使用する」オプションを利用しアノテーションを行
うと、下図のようになります。

「シートのRef番号を*1000 から開始し、最初の空き番号から使用する」オプションを利用した場合は、下図のよ
うになります。
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ERC (エレクトリカル・ルール・チェック) による設
計検証
はじめに
ERC (エレクトリカル・ルール・チェック) ツールは回路図の自動チェックを実行します。ERC は、未接続ピン、
未接続の階層シンボル、出力ショートなどのようなシート内のすべてのエラーをチェックします。当然ながら、自
動チェックは絶対確実なものではありませんし、設計エラーを検出するソフトウェアは１００％完全ではありませ
ん。しかし、そのようなチェックは多くの見落としや小さな間違いを検出するので非常に便利です。

実際には、次の工程へと進む前に検出された全てのエラーをチェックして正常な状態になるよう修正する必要があ
ります。ERC の質は、シンボル ライブラリー作成中にピンの電気的なプロパティをどれだけ細かく指定したかに
依ります。ERC の出力は “エラー” または “警告” として報告されます。

ERC の使用法
ERC can be started by clicking on the icon .

マーカーは、ERC エラーを出力した回路図の要素（ピンまたはラベル）上に配置されます。

NOTE

“エレクトリカル・ルール・チェック (ERC)” ダイアログ内でエラーメッセージをクリック
すると、回路図内の対応するマーカーに移動できます。

回路図中に表示されたマーカーを右クリックすることで、診断結果のメッセージへアクセ
スすることができます。

You can also delete error markers from the dialog and set specific ERC messages to be suppressed by using
the right-click context menu.
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ERC の例

エラーが４つ見られます：

２本の出力が誤接続されています（赤の矢印）。

入力が２本未接続のままです（緑の矢印）。

非表示電源ポートのエラーで，電源フラグがありません（上部に緑の矢印）。

診断結果の表示
マーカーを右クリックし、コンテキストメニューを表示します。



68

ここで、 “マーカーエラー情報” をクリックするとエラーの内容が “マーカーの情報” ウィンドウに表示されます。

電源ピンと電源フラグ
電源ピンにエラーまたは警告を出すのは一般的です。たとえ、すべて正常のように思われるとしてもです。上の例
を参照して下さい。大抵の設計では電源はコネクタによって供給されますが、そのコネクタは（電源出力として宣
言されているレギュレータ出力のような）電源ではありません。

このためERCは、電源出力ピンを検出してこの配線を操作するということはせず、電源で駆動されていないものと
判断します。

この警告を避けるには、そのような電源ポートに “PWR_FLAG” を配置しなければなりません．次の例を参照して
下さい。:
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このようにすると、エラーマーカーが消えます。

大抵の場合、PWR_FLAG は GND に接続されていなければなりません。なぜなら、レギュレータは電源出力とし
て宣言された出力を持ちますが、グラウンドピンは電源出力ではない（通常の属性は電源入力）ため、
PWR_FLAG に接続しなければ電源に接続されたことにはならないからです。

ルールの設定
The Pin Conflicts Map panel in Schematic Setup allows you to configure connectivity rules to define electrical
conditions for errors and warnings based on what types of pins are connected to each other

マトリクス内の変更したい四角をクリックすると，ノーマル，警告，エラーの選択が順番に切り替わり、ルールの
変更が可能です。
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The Violation Severity panel in Schematic Setup lets you configure what types of ERC messages should be
reported as Errors, Warnings or ignored.

ERC レポートファイル
オプションの ERC レポートの作成にチェックを付けると、ERC レポートファイルの生成と保存が可能です。ERC
レポートのファイル拡張子は、.erc です。ERC レポートファイルの例を示します。

ERC control (4/1/1997-14:16:4) 
 
***** Sheet 1 (INTERFACE UNIVERSAL) 
ERC: Warning Pin input Unconnected @ 8.450, 2.350 
ERC: Warning passive Pin Unconnected @ 8.450, 1.950 
ERC: Warning: BiDir Pin connected to power Pin (Net 6) @ 10.100, 3.300 
ERC: Warning: Power Pin connected to BiDir Pin (Net 6) @ 4.950, 1.400 
 
>> Errors ERC: 4
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Transfer Schematic to PCB
概要
Use the Update PCB from Schematic tool to sync design information from the Schematic Editor to the Board
Editor. The tool can be accessed with Tools → Update PCB from Schematic ( ) in both the schematic and

board editors. You can also use the  icon in the top toolbar of the Board Editor.

NOTE

Update PCB from Schematic is the preferred way to transfer design information from the
schematic to the PCB. In older versions of KiCad, the equivalent process was to export a
netlist from the Schematic Editor and import it into the Board Editor. It is no longer
necessary to use a netlist file.

The tool adds the footprint for each symbol to the board and transfers updated schematic information to
the board. In particular, the board’s net connections are updated to match the schematic.

The changes that will be made to the PCB are listed in the Changes To Be Applied pane. The PCB is not
modified until you click the Update PCB button.

You can show or hide different types of messages using the checkboxes at the bottom of the window. A
report of the changes can be saved to a file using the Save…  button.

Options
The tool has several options to control its behavior.

F8
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Option Description

Re-link footprints to schematic
symbols based on their reference
designators

Footprints are normally linked to schematic symbols via a unique
identifier created when the symbol is added to the schematic. A
symbol’s unique identifier cannot be changed.

If checked, each footprint in the PCB will be re-linked to the symbol
that has the same reference designator as the footprint.

If unchecked, footprints and symbols will be linked by unique
identifier as usual, rather than by reference designator. Each
footprint’s reference designator will be updated to match the
reference designator of its linked symbol.

This option should generally be left unchecked. It is useful for
specific workflows that rely on changing the links between schematic
symbols and footprints, such as refactoring a schematic for easier
layout or replicating layout between identical channels of a design.

Delete footprints with no
symbols

If checked, any footprint in the PCB without a corresponding symbol
in the schematic will be deleted from the PCB. Footprints with the
"Not in schematic" attribute will be unaffected.

If unchecked, footprints without a corresponding symbol will not be
deleted.

Replace footprints with those
specified in the schematic

If checked, footprints in the PCB will be replaced with the footprint
that is specified in the corresponding schematic symbol.

If unchecked, footprints that are already in the PCB will not be
changed, even if the schematic symbol is updated to specify a
different footprint.
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プロットと印刷
はじめに
上部メニューバーの “ファイル” から “印刷 (N)” と “プロット (P)” の両コマンドが実行可能です。

プロットでサポートしている出力フォーマットは、PostScript、PDF、SVG、DXF、HPGL です。自分のプリンタ
ーで直接印刷することも可能です。

プロットの共通コマンド
現在のページをプロット

現在のシートのみプロットします。

全てのページをプロット

全階層をプロットします（各シート毎に印刷ファイルを１つ生成する）。

Postscript のプロット
“回路図のプロット” 内のフォーマットで PostScript オプションを指定します。

ファイル名はシート名に拡張子 .ps を付加したものになります。“シートの図枠を印刷” オプションを無効にするこ
とが可能です。これは文書編集ソフトウェアで図を挿入するためにしばしば使用されるカプセル化ポストスクリプ
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トファイル（ .eps フォーマット）を生成する場合に便利です。メッセージ ウィンドウは生成されたファイル名を
表示します。

PDF のプロット

“回路図のプロット” 内のフォーマットで PDF オプションを指定します。ファイル名はシート名に拡張子 .pdf を付
加したものになります。

SVG のプロット

“回路図のプロット” 内のフォーマットで SVG オプションを指定します。ファイル名はシート名に拡張子 .svg を付
加したものになります。
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DXF のプロット

“回路図のプロット” 内のフォーマットで DXF オプションを指定します。ファイル名はシート名に拡張子 .dxf を付
加したものになります。

HPGL のプロット
“回路図のプロット” 内のフォーマットで HPGL オプションを指定します。このフォーマットでは、以下を定義可
能です:

ページ サイズ。

原点。

ペン幅 (mm単位)。

以下は “回路図のプロット” ダイアログです。（上部メニューバーから、ファイル → プロット → プロットを選択
します。）:

出力ファイル名はシート名に拡張子 .plt を付加したものです。
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シートサイズ選択
通常は “回路図の大きさ” が選択されています。この場合、ページ設定で定義されているサイズが使用され、その
時のスケールは１になります。異なるサイズ（ A4 ～ A0 あるいは A ～ E ）を選択すると、スケールが自動的に調
整されてページにフィットします。

オフセット調整
全ての標準的な寸法に対して、可能な限り正確に中央に描画するようにオフセットを調整できます。プロッターは
原点がシートの中央か左下角にあるので、適切にプロットするためにはオフセットを挿入する必要があります。

一般的には:

シートの中央を原点とするプロッターの場合、オフセットは負の値で、シート寸法の 1/2 に設定しなければな
りません。

シートの左下角を原点とするプロッターの場合、オフセットは 0 に設定しなければなりません。

オフセットを設定するには:

シートサイズを選択。

原点を選択。

（ “左下の角” または “ページ中央” を選択）

紙面印刷
This command, available via the icon , allows you to visualize and generate design files for the standard

printer.

“シートのリファレンスと図枠の印刷” オプションは、シートのリファレンスおよびタイトルブロックの有効／無効
を切り替えます。

“モノクロ印刷” オプションは印刷をモノクロ印刷に最適化します。通常、このオプションはモノクロのレーザープ
リンターを使用する場合に必要です。それは、カラーがハーフトーンで印刷されて非常に読みにくくなることがよ
くあるからです。
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Symbol Editor
シンボル・ライブラリーに関する一般情報
A symbol is a schematic element which contains a graphical representation, electrical connections, and text
fields describing the symbol. Symbols used in a schematic are stored in symbol libraries. KiCad provides a
symbol editing tool that allows you to create libraries, add, delete or transfer symbols between libraries,
export symbols to files, and import symbols from files. The symbol editing tool provides a simple way to
manage symbols and symbol libraries.

シンボル・ライブラリーの概要
シンボル・ライブラリーは１つ以上のシンボルから構成されています。基本的にシンボルは、機能、種類、あるい
は製造元によって論理的にグループ化されます。

シンボルは次の要素で構成されています:

Graphical items (lines, circles, arcs, text, etc.) that determine how symbol looks in a schematic.

Pins which have both graphic properties (line, clock, inverted, low level active, etc.) and electrical
properties (input, output, bidirectional, etc.) used by the Electrical Rules Check (ERC) tool.

フィールド：リファレンス、値、基板 (PCB) 設計のための対応するフットプリント名など

Symbols can be derived from another symbol in the same library. Derived symbols share the base symbol’s
graphical shape and pin definitions, but can override the base symbol’s property fields (value, footprint,
footprint filters, datasheet, description, etc.). Derived symbols can be used to define symbols that are similar
to a base part. For example, 74LS00, 74HC00, and 7437 symbols could all be derived from a 7400 symbol. In
previous versions of KiCad, derived symbols were referred to as aliases.

適切なシンボルの設計には以下のことが要求されます:

一つ以上のユニットで構成されるようにシンボルを定義する。

Defining if the symbol has an alternate body style (also known as a De Morgan representation).

ライン、矩形、円、ポリゴンおよびテキストを使用して回路図シンボル（記号）を設計する。

グラフィック要素、名前、ピン数、電気的プロパティ（入力、出力、３ステート、電源ポートなど）を慎重に
定義して、ピンを追加する。

Determining if the symbol should be derived from another symbol with the same graphical design and
pin definition.

PCB 設計ソフトウェアが使用するフットプリント名のような補助的フィールドを追加し、それらの可視性を定
義する。

説明文やデータシートへのリンクなどを付加してシンボルに記録する。

適切な (desired) ライブラリーにそれを保存する。

シンボル・ライブラリー・エディターの概要
シンボル・ライブラリー・エディターのメインウィンドウを以下に示します。よく使う機能を手早く使えるように
するための３つのツールバーとシンボルの閲覧／編集エリアで構成されます。ツールバーからは全てのコマンドを
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使うことができませんが、メニューからは使用できます。

メイン・ツールバー
The main tool bar is located at the top of the main window. It consists of the undo/redo commands, zoom
commands, symbol properties dialogs, and unit/representation management controls.
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Create a new symbol in the selected library.

Save the currently selected library. All modified symbols in the library will be saved.

Undo last edit.

Redo last undo.

Refresh display.

Zoom in.

Zoom out.

Zoom to fit symbol in display.

Zoom to fit selection.

Rotate counter-clockwise.

Rotate clockwise.

Mirror horizontally.

Mirror vertically.

Edit the current symbol properties.

Edit the symbol’s pins in a tablular interface.

Open the symbol’s datasheet. The button will be disabled if no datasheet is defined
for the current symbol.

Test the current symbol for design errors.

Select the normal body style. The button is disabled if the current symbol does not
have an alternate body style.

Select the alternate body style. The button is disabled if the current symbol does not
have an alternate body style.

Select the unit to display. The drop down control will be disabled if the current
symbol is not derived from a symbol with multiple units.

Enable synchronized pins edit mode. When this mode is enabled, any pin
modifications are propagated to all other symbol units. Pin number changes are not
propagated. This mode is automatically enabled for symbols with multiple
interchangable units and cannot be enabled for symbols with only one unit.
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エレメント・ツールバー
The vertical toolbar located on the right hand side of the main window allows you to place all of the
elements required to design a symbol.

Select tool. Right-clicking with the select tool opens the context menu for the object under the
cursor. Left-clicking with the select tool displays the attributes of the object under the cursor
in the message panel at the bottom of the main window. Double-left-clicking with the select
tool will open the properties dialog for the object under the cursor.

Pin tool. Left-click to add a new pin.

Graphical text tool. Left-click to add a new graphical text item.

Rectangle tool. Left-click to begin drawing the first corner of a graphical rectangle. Left-click
again to place the opposite corner of the rectangle.

Circle tool. Left-click to begin drawing a new graphical circle from the center. Left-click again
to define the radius of the circle.

Arc tool. Left-click to begin drawing a new graphical arc item from the first arc end point. Left-
click again to define the second arc end point. Adjust the radius by dragging the arc center
point.

Connected line tool. Left-click to begin drawing a new graphical line item in the current
symbol. Left-click for each additional connected line. Double-left-click to complete the line.

Anchor tool. Left-click to set the anchor position of the symbol.

Delete tool. Left-click to delete an object from the current symbol.

オプション・ツールバー
The vertical tool bar located on the left hand side of the main window allows you to set some of the editor
drawing options.

Toggle grid visibility on and off.

Set units to inches.

Set units to mils (0.001 inch).

Set units to millimeters.

Toggle full screen cursor on and off.

Toggle display of pin electrical types.

Toggle display of libraries and symbols.
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ライブラリーの選択および保守
The selection of the current library is possible via the  icon which shows you all available libraries and

allows you to select one. When a symbol is loaded or saved, it will be put in this library. The library name of
a symbol is the contents of its Value  field.

シンボルの選択と保存

シンボルの選択
Clicking the  icon on the left tool bar toggles the treeview of libraries and symbols. Clicking on a symbol

opens that symbol.

NOTE

Some symbols are derived from other symbols. Derived symbol names are displayed in
italics in the treeview. If a derived symbol is opened, its symbol graphics will not be
editable. Its symbol fields will be editable as normal. To edit the graphics of a base symbol
and all of its derived symbols, open the base symbol.

シンボルの保存
After modification, a symbol can be saved in the current library or a different library.

To save the modified symbol in the current library, click the  icon. The modifications will be written to

the existing symbol.

NOTE Saving a modified symbol also saves all other modified symbols in the same library.

To save the symbol changes to a new symbol, click File → Save As… . The symbol can be saved in the current
library or a different library. A new name can be set for the symbol.

To create a new file containing only the current symbol, click File → Export → Symbol… . This file will be a
standard library file which will contain only one symbol.

ライブラリー・シンボルの作成
新規シンボルの作成
A new symbol can be created by clicking the  icon. You will be asked for a number of symbol properties.

A symbol name (this name is used as the default value for the Value  field in the schematic editor)

An optional base symbol to derive the new symbol from. The new symbol will use the base symbol’s
graphical shape and pin configuration, but other symbol information can be modified in the derived
symbol. The base symbol must be in the same library as the new derived symbol.

The reference designator prefix ( U , C , R… ).

The number of units per package, and whether those units are interchangeable (for example a 7400 is
made of 4 units per package).

If an alternate body style (sometimes referred to as a "De Morgan equivalent") is desired.

Whether the symbol is a power symbol. Power symbols appear in the "Add Power Port" dialog in the
Schematic editor, their Value  fields are not editable in the schematic, they cannot be assigned a



82

footprint and they are not added to the PCB, and they are not included in the bill of materials.

Whether the symbol should be excluded from the bill of materials.

Whether the symbol should be excluded from the PCB.

There are also several graphical options.

The offset between the end of each pin and its pin name.

Whether the pin number and pin name should be displayed.

Whether the pin names should be displayed alongside the pins or at the ends of the pins inside the
symbol body.

These properties can also be changed later in the Symbol Properties window.

上のプロパティを使って新しくシンボルを作成すると、シンボル・ライブラリー・エディターの画面は次のように
なります。
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The blue cross in the center is the symbol anchor, which specifies the symbol origin i.e. the coordinates (0, 0).
The anchor can be repositioned by selecting the  icon and clicking on the new desired anchor position.

他のシンボルからシンボルを作成
作成したいと思っているシンボルが、シンボル・ライブラリーに既にあるものと似ているということはよくありま
す。この場合、既存のシンボルを読み込んで変更すると簡単です。

出発点として使うシンボルを読み込みます。

Save a new copy of the symbol using File → Save As… . The Save As dialog will prompt for a name for the
new symbol and the library to save it in.

必要に応じて新規シンボルを編集します。

Save the modified symbol.

シンボル・プロパティ
Symbol properties are set when the symbol is created but they can be modified at any point. To change the

symbol properties, click on the  icon to show the dialog below.
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It is important to correctly set the number of units per package and the alternate symbolic representation, if
enabled, because when pins are edited or created the corresponding pins for each unit will be affected. If
you change the number of units per package after pin creation and editing, there will be additional work to
specify the pins and graphics for the new unit. Nevertheless, it is possible to modify these properties at any
time.

The graphic options "Show pin number" and "Show pin name" define the visibility of the pin number and pin
name text. The option "Place pin names inside" defines the pin name position relative to the pin body. The
pin names will be displayed inside the symbol outline if the option is checked. In this case the "Pin Name
Position Offset" property defines the shift of the text away from the body end of the pin. A value from 0.02
to 0.05 inches is usually reasonable.

以下の例は、”ピン名を内側に配置” オプションにチェックをつけない状態のシンボルを示しています。ピン名とピ
ン番号の位置に注意して下さい。
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Symbol Name, Description, and Keywords
The symbol’s name is the same as the Value  field. When the symbol name is changed the value also changes,
and vice versa. The symbol’s name in the library also changes accordingly.

The symbol description should contain a brief description of the component, such as the component
function, distinguishing features, and package options. The keywords should contain additional terms
related to the component. Keywords are used primarily to assist in searching for the symbol.
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A symbol’s name, description, and keywords are all used when searching for symbols in the Symbol Editor
and Add a Symbol dialog. The description and keywords are displayed in the Symbol Library Browser and
Add a Symbol dialog.

Footprint Filters
The footprint filters tab is used to define which footprints are appropriate to use with the symbol. The
filters can be applied in the Footprint Assignment tool so that only appropriate footprints are displayed for
each symbol.

Multiple footprint filters can be defined. Footprints that match any of the filters will be displayed; if no
filters are defined, then all footprints will be displayed.

Filters can use wildcards: *  matches any number of characters, including zero, and ?  matches zero or one
characters. For example, SOIC-*  would match the SOIC-8_3.9x4.9mm_P1.27mm  footprint as well as any
other footprint beginning with SOIC- . The filter SOT?23  matches SOT23  as well as SOT-23 .
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代替シンボル表現をもつシンボル
If the symbol has an alternate body style defined, one body style must be selected for editing at a time. To
edit the normal representation, click the  icon.

To edit the alternate representation, click on the  icon. Use the  dropdown shown below

to select the unit you wish to edit.

グラフィック要素
Graphical elements create the visual representation of a symbol and contain no electrical connection
information. Graphical elements are created with the following tools:

始点と終点で定義されたラインとポリゴン。

対角線にある２つのコーナーで定義された矩形。

中心と半径で定義された円。

始点と終点および中心で定義された円弧。（円弧は 0° から 180° まで描画できます。）

メイン・ウィンドウの右側にある縦ツールバーには、シンボルの表現をデザインするために必要な全てのグラフィ
ック要素を配置できます。

グラフィック要素のメンバーシップ。
個々のグラフィック要素（ライン、円弧、円など）は、全てのユニットで共通／全てのボディスタイルで共通／ユ
ニット毎／ボディスタイル毎に定義することが可能です。要素オプションは、選択した要素を右クリックしてコン
テキストメニューを表示することで簡単に設定できます。次にラインのコンテキストメニューの例を示します。
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またこの要素を左ダブルクリックすると要素のプロパティを変更できます。次に多角形のプロパティダイアログの
例を示します。

グラフィック要素のプロパティは次の通りです。:

"Line width" defines the width of the element’s line in the current drawing units.

"Fill Style" determines if the shape defined by the graphical element is to be drawn unfilled, background
filled, or foreground filled.

"Common to all units in symbol" determines if the graphical element is drawn for each unit in symbol
with more than one unit per package or if the graphical element is only drawn for the current unit.

"Common to all body styles (De Morgan)" determines if the graphical element is drawn for each symbolic
representation in symbols with an alternate body style or if the graphical element is only drawn for the
current body style.

グラフィック・テキスト要素
The  icon allows for the creation of graphical text. Graphical text is automatically oriented to be

readable, even when the symbol is mirrored. Please note that graphical text items are not the same as
symbol fields.

複数ユニット・シンボルと代替ボディ・スタイル
Symbols can have up to two body styles (a standard symbol and an alternate symbol often referred to as a
"De Morgan equivalent") and/or have more than one unit per package (logic gates for example). Some
symbols can have more than one unit per package each with different symbols and pin configurations.
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Consider for instance a relay with two switches, which can be designed as a symbol with three different
units: a coil, switch 1, and switch 2. Designing a symbol with multiple units per package and/or alternate
body styles is very flexible. A pin or a body symbol item can be common to all units or specific to a given unit
or they can be common to both symbolic representation so are specific to a given symbol representation.

By default, pins are specific to a unit and body style. When a pin is common to all units or all body styles, it
only needs to be created once. This is also the case for the body style graphic shapes and text, which may be
common to each unit, but typically are specific to each body style).

Example of a Symbol With Multiple Noninterchangeable Units
For an example of a symbol with multiple units that are not interchangeable, consider a relay with 3 units
per package: a coil, switch 1, and switch 2.

The three units are not all the same, so "All units are interchangeable" should be deselected in the Symbol
Properties dialog. Alternatively, this option could have been specified when the symbol was initially created.

Unit A
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Unit B

Unit C

Unit A does not have the same symbol and pin layout as Units B and C, so the units are not interchangeable.

NOTE

"Synchronized Pins Edit Mode" can be enabled by clicking the  icon. In this mode, pin
modifications are propagated between symbol units; changes made in one unit will be
reflected in the other units as well. When this mode is disabled, pin changes made in one
unit do not affect other units. This mode is enabled automatically when "All units are
interchangeable" is checked, but it can be disabled. The mode cannot be enabled when "All
units are interchangeable" is unchecked or when the symbol only has one unit.

グラフィック・シンボル要素
Shown below are properties for a graphic body element. In the relay example above, the three units have
different symbolic representations. Therefore, each unit was created separately and the graphical body
elements have the "Common to all units in symbol" setting disabled.
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ピンの作成および編集
You can click on the  icon to create and insert a pin. The editing of all pin properties is done by double-

clicking on the pin or right-clicking on the pin to open the pin context menu. Pins must be created carefully,
because any error will have consequences on the PCB design. Any pin already placed can be edited, deleted,
and/or moved.

ピンの概要
A pin is defined by its graphical representation, its name and its number. The pin’s name and number can
contain letters, numbers, and symbols, but not spaces. For the Electrical Rules Check (ERC) tool to be useful,
the pin’s electrical type (input, output, tri-state… ) must also be defined correctly. If this type is not defined
properly, the schematic ERC check results may be invalid.

重要な注意

Symbol pins are matched to footprint pads by number. The pin number in the symbol must match the
corresponding pad number in the footprint.

Do not use spaces in pin names and numbers. Spaces will be automatically replaced with underscores
( _ ).

To define a pin name with an inverted signal (overline) use the ~  (tilde) character followed by the text
to invert in braces. For example ~{FO}O  would display FO O.

If the pin name is empty, the pin is considered unnamed.

Pin names can be repeated in a symbol.

Pin numbers must be unique in a symbol.
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ピンのプロパティ

ピンプロパティダイアログでピンの全ての特性を編集することができます。このダイアログは、ピンを作成した
り、あるいは既存のピンをダブルクリックすると、自動的にポップアップします。このメニューで以下の定義また
は変更が可能です。:

The pin name and text size.

The pin number and text size.

The pin length.

The pin electrical type and graphical style.

“コンポーネントの全てのユニットで共通” および “全てのボディスタイル（ド・モルガン）で共有する (S)”

Pin visibility.

Alternate pin definitions.

Pin Graphic Styles
Shown in the figure below are the different pin graphic styles. The choice of graphic style does not have any
influence on the pin’s electrical type.
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ピンの電気的タイプ
Choosing the correct electrical type is important for the schematic ERC tool. ERC will check that pins are
connected appropriately, for example ensuring that input pins are driven and power inputs receive power
from an appropriate source.

Pin Type Description

Input A pin which is exclusively an input.

Output A pin which is exclusively an output.

Bidirectional A pin that can be either an input or an output, such as a microcontroller data
bus pin.

Tri-state A three state output pin (high, low, or high impedance)

Passive A passive symbol pin: resistors, connectors, etc.

Free A pin that can be freely connected to any other pin without electrical concerns.

Unspecified A pin for which the ERC check does not matter.

Power input A symbol’s power pin. As a special case, power input pins that are marked
invisible are automatically connected to the net with the same name. See the
Power Ports section for more information.

Power output A pin that provides power to other pins, such as a regulator output.

Open collector An open collector logic output.

Open emitter An open emitter logic output.

Unconnected A pin that should not be connected to anything.

Pushing Pin Properties to Other Pins
You can apply the length, name size, or number size of a pin to the other pins in the symbol by right clicking
the pin and selecting Push Pin Length, Push Pin Name Size, or Push Pin Number Size, respectively.

複数ユニットおよび代替シンボル表現におけるピン定義
Symbols with multiple units and/or graphical representations are particularly problematic when creating
and editing pins. The majority of pins are specific to each symbol unit (because each unit has a different set
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of pins) and to each body style (because the form and position is different between the normal body style
and the alternate form).

The symbol library editor allows the simultaneous creation of pins. By default, changes made to a pin are
made for all units of a multiple unit symbol and to both representations for symbols with an alternate
symbolic representation. The only exception to this is the pin’s graphical type and name, which remain
unlinked between symbol units and body styles. This dependency was established to allow for easier pin

creation and editing in most cases. This dependency can be disabled by toggling the  icon on the main

tool bar. This will allow you to create pins for each unit and representation completely independently.

Pins can be common or specific to different units. Pins can also be common to both symbolic representations
or specific to each symbolic representation. When a pin is common to all units, it only has to drawn once.
Pins are set as common or specific in the pin properties dialog.

An example is the output pin in the 7400 quad dual input NAND gate. Since there are four units and two
symbolic representations, there are eight separate output pins defined in the symbol definition. When
creating a new 7400 symbol, unit A of the normal symbolic representation will be shown in the library
editor. To edit the pin style in the alternate symbolic representation, it must first be enabled by clicking the 

 button on the tool bar. To edit the pin number for each unit, select the appropriate unit using the 

 drop down control.

Pin Table
Another way to edit pins is to use the Pin Table, which is accessible via the  icon. The Pin Table displays

all of the pins in the symbol and their properties in a table view, so it is useful for making bulk pin changes.

Any pin property can be edited by clicking on the appropriate cell. Pins can be added and removed with the 
 and  icons, respectively.

NOTE Columns of the pin table can be shown or hidden by right-clicking on the header row and
checking or unchecking additional columns. Some columns are hidden by default.

The screenshot below shows the pin table for a quad opamp.
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Alternate Pin Definitions
Pins can have alternate pin definitions added to them. Alternate pin definitions allow a user to select a
different name, electrical type, and graphical style for a pin when the symbol has been placed in the
schematic. This can be used for pins that have multiple functions, such as microcontroller pins.

Alternate pin definitions are added in the Pin Properties dialog as shown below. Each alternate definition
contains a pin name, electrical type, and graphic style. This microcontroller pin has all of its peripheral
functions defined in the symbol as alternate pin names.
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Alternate pin definitions are selected in the Schematic Editor once the symbol has been placed in the
schematic. The alternate pin is assigned in the Alternate Pin Assignments tab of the Symbol Properties
dialog. Alternate definitions are selectable in the dropdown in the Alternate Assignment column.
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シンボルのフィールド
All library symbols are defined with four default fields. The reference designator, value, footprint
assignment, and datasheet link fields are created whenever a symbol is created or copied. Only the reference
designator and value fields are required.

Symbols defined in libraries are typically defined with only these four default fields. Additional fields such
as vendor, part number, unit cost, etc. can be added to library symbols but generally this is done in the
schematic editor so the additional fields can be applied to all of the symbols in the schematic.

NOTE

A convenient way to create additional empty symbol fields is to use define field name
templates. Field name templates define empty fields that are added to each symbol when
it is inserted into the schematic. Field name templates can be defined globally (for all
schematics) in the Schematic Editor Preferences, or they can be defined locally (specific to
each project) in the Schematic Setup dialog.

シンボル・フィールドの編集
既存シンボルのフィールドを編集するには、フィールド・テキストを右クリックして下のフィールド・コンテキス
トメニューを表示します。
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To add new fields, delete optional fields, or edit existing fields, use the  icon on the main tool bar to open

the Symbol Properties dialog.

Fields are text information associated a the symbol. Do not confuse them with text in the graphic
representation of a symbol.

重要な注意

Modifying the Value  field changes the name of the symbol. The symbol’s name in the library will change
when the symbol is saved.

The Symbol Properties dialog must be used to edit a field that is empty or has the invisible attribute
enabled because such fields cannot be clicked on.

The footprint is defined as an absolute footprint using the LIBNAME:FOOTPRINTNAME  format where
LIBNAME  is the name of the footprint library defined in the footprint library table (see the "Footprint
Library Table" section in the PCB Editor manual) and FOOTPRINTNAME  is the name of the footprint in the
library LIBNAME .

Power Ports
Power ports, or power symbols, are conventionally used to label a wire as part of a power net, like VCC ,
+5V , or GND . In the schematic below, the +3.3V  and GND  symbols are power ports. In addition to acting as a
visual indicator that a net is a power rail, a power port will determine the name of the net it is attached to.
This is true even if there is another net label attached to the net; the net name determined by the power
symbol overrides any other net names.
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It may be useful to place power symbols in a dedicated library. KiCad’s symbol library places power symbols
in the power  library, and users may create libraries to store their own power symbols. If the "Define as
power symbol" box is checked in a symbol’s properties, that symbol will appear in the Schematic Editor’s
"Add Power Port" dialog for convenient access.

Power symbols are handled and created the same way as normal symbols, but there are several additional
considerations described below. They consist of a graphical symbol and a pin of the type "Power input" that
is marked hidden.

Below is an example of a GND  power symbol.

Creating a Power Port Symbol
Power Port symbols consist of a pin of type "Power input" that is marked invisible. Invisible power input
pins have a special property of automatically connecting to a net with the same name as the pin name. A net
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that is wired to an invisible power input pin will therefore be named after the pin, even if there are other
net labels on the net. This connection is global.

NOTE
If the power symbol has the "Define as power symbol" property checked, the power input
pin does not need to be marked invisible. However, the convention is to make these pins
invisible anyway.

以下のステップに従ってシンボルを作成します。:

Add a pin of type "Power input", with "Visible" unchecked, and the pin named according to the desired
net. Make the pin number 1 , the length 0 , and set the graphic style to "Line". The pin name establishes
the connection to the net; in this case the pin will automatically connect to the net GND . The pin number,
length, and line style do not matter electrically.

Place the pin on the symbol anchor.

Use the shape tools to draw the symbol graphics.

Set the symbol value. The symbol value does not matter electrically, but it is displayed in the schematic.
To eliminate confusion, it should match the pin name (which determines the connected net name).

Check the "Define as power symbol" box in Symbol Properties window. This makes the symbol appear in
the "Add Power Port" dialog, makes the Value  field read-only in the schematic, prevents the symbol
from being assigned a footprint, and excludes the symbol from the board, BOM, and netlists.

Set the symbol reference and uncheck the "Show" box. The reference text is not important except for the
first character, which should be # . For the power port shown above, the reference could be #GND .
Symbols with references that begin with #  are not added to the PCB, are not included in Bill of Materials
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exports or netlists, and they cannot be assigned a footprint in the footprint assignment tool. If a power
port’s reference does not begin with # , the character will be inserted automatically when the annotation
or footprint assignment tools are run.

An easier method to create a new power port symbol is to use another symbol as a starting point, as
described earlier.

NOTE When modifying an existing power port symbol, make sure to rename the pin name so
that the new symbol connects to the appropriate power net.
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シンボル・ライブラリー・ブラウザー
はじめに
The Symbol Library Browser allows you to quickly examine the content of symbol libraries. The Symbol

Library Viewer can be accessed by clicking  icon on the main toolbar, View → Symbol Library

Browser… , or clicking Select With Browser in the "Choose Symbol" window.

Viewlib - メイン・スクリーン

ライブラリーの内容を確認するには、左側のリストからライブラリーを選択する必要があります。選択したライブ
ラリーに含まれる利用可能な全てのシンボルが左から２番目のパネルに表示されます。シンボル名を選択すると、
シンボルの内容を確認できます。
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シンボル・ライブラリー・ブラウザーの上部ツールバー
シンボル・ライブラリー・ブラウザーの上部に表示されているツールバーを以下に示します。

利用可能なコマンドは以下のとおりです :

Selection of the symbol which can be also selected in the displayed list.

Display previous symbol.

Display next symbol.

   Zoom tools.

 Selection of the representation (normal or alternate) if an alternate representation
exists.

Selection of the unit for symbols that contain multiple units.

If they exist, display the associated documents.

Close the browser and place the selected symbol in the schematic.
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ネットリストの作成
概要
A netlist is a file which describes electrical connections between symbol pins. These connections are referred
to as nets. Netlist files contain:

A list of symbols and their pins.

A list of connections (nets) between symbol pins.

Many different netlist formats exist. Sometimes the symbols list and the list of nets are two separate files.
This netlist is fundamental in the use of schematic capture software, because the netlist is the link with other
electronic CAD software, such as:

PCB レイアウト ソフトウェア。（基板設計ソフト）

回路および電気的な信号シミュレータ。

Programmable logic (FPGA, CPLD, etc.) compilers.

KiCad supports several netlist formats:

KiCad format, which can be imported by the KiCad PCB Editor. However, the "Update PCB from
Schematic" tool should be used instead of importing a KiCad netlist into the PCB editor.

OrCAD PCB2 format, for designing PCBs with OrCAD.

CADSTAR format, for designing PCBs with CADSTAR.

Spice format, for use with various external circuit simulators.

NOTE
In KiCad version 5.0 and later, it is not necessary to create a netlist for transfering a design
from the schematic editor to the PCB editor. Instead, use the "Update PCB from
Schematic" tool.

ネットリストフォーマット
Netlists are exported with the Export Netlist dialog (File→Export→Netlist… ).

Several netlist formats are available, and are selectable with the tabs at the top of the window. Some netlist
formats have options.

Clicking the Export Netlist button prompts for a netlist filename and saves the netlist.

NOTE Netlist generation can take up to several minutes for large schematics.

Custom generators can be added by clicking the Add Generator…  button. Custom generators are external
tools that are called by KiCad, for example Python scripts or XSLT stylesheets. For more information on
custom netlist generators, see the section on adding custom netlist generators.
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KiCad Netlist Format

The KiCad netlist exporter does not have any options.

NOTE
In KiCad version 5.0 and later, it is not necessary to create a netlist for transfering a design
from the schematic editor to the PCB editor. Instead, use the "Update PCB from
Schematic" tool.

OrCAD PCB2 Netlist Format

The OrCAD netlist exporter does not have any options.
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CADSTAR Netlist Format

The CADSTAR netlist exporter does not have any options.

Spice Netlist Format

The Spice netlist format offers several options.

When the Reformat passive symbol values box is checked, passive symbol values will be adjusted to be
compatible with Spice. Specifically:

μ  and M  as unit prefixes are replaced with u  and Meg , respectively

Units are removed (e.g. 4.7kΩ  is changed to 4.7k )

Values in RKM format are rewritten to be Spice-compatible (e.g. 4u7  is changed to 4.7u )

The Spice netlist exporter also provides an easy way to simulate the generated netlist with an external
simulator. This can be useful for running a simulation without using KiCad’s internal ngspice simulator, or
for running an ngspice simulation with options that are not supported by KiCad’s simulator tool.

Enter the path to the external simulator in the text box, with %I  representing the generated netlist. Click
the Create Netlist and Run Simulator Command button to generate the netlist and automatically run the
simulator.

NOTE The default simulator command ( spice "%I" ) must be adjusted to point to a simulator
installed on your system.
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For more information on the contents of Spice netlists, see the Spice netlist section.

ネットリストの例
Below is the schematic from the sallen_key  project included in KiCad’s simulation demos.

The KiCad format netlist for this schematic is as follows:
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(export (version "E") 
  (design 
    (source "/usr/share/kicad/demos/simulation/sallen_key/sallen_key.kicad_sch") 
    (date "Sun 01 May 2022 03:14:05 PM EDT") 
    (tool "Eeschema (6.0.4)") 
    (sheet (number "1") (name "/") (tstamps "/") 
      (title_block 
        (title) 
        (company) 
        (rev) 
        (date) 
        (source "sallen_key.kicad_sch") 
        (comment (number "1") (value "")) 
        (comment (number "2") (value "")) 
        (comment (number "3") (value "")) 
        (comment (number "4") (value "")) 
        (comment (number "5") (value "")) 
        (comment (number "6") (value "")) 
        (comment (number "7") (value "")) 
        (comment (number "8") (value "")) 
        (comment (number "9") (value ""))))) 
  (components 
    (comp (ref "C1") 
      (value "100n") 
      (libsource (lib "sallen_key_schlib") (part "C") (description "")) 
      (property (name "Sheetname") (value "")) 
      (property (name "Sheetfile") (value "sallen_key.kicad_sch")) 
      (sheetpath (names "/") (tstamps "/")) 
      (tstamps "00000000-0000-0000-0000-00005789077d")) 
    (comp (ref "C2") 
      (value "100n") 
      (fields 
        (field (name "Fieldname") "Value") 
        (field (name "SpiceMapping") "1 2") 
        (field (name "Spice_Primitive") "C")) 
      (libsource (lib "sallen_key_schlib") (part "C") (description "")) 
      (property (name "Fieldname") (value "Value")) 
      (property (name "Spice_Primitive") (value "C")) 
      (property (name "SpiceMapping") (value "1 2")) 
      (property (name "Sheetname") (value "")) 
      (property (name "Sheetfile") (value "sallen_key.kicad_sch")) 
      (sheetpath (names "/") (tstamps "/")) 
      (tstamps "00000000-0000-0000-0000-00005789085b")) 
    (comp (ref "R1") 
      (value "1k") 
      (fields 
        (field (name "Fieldname") "Value") 
        (field (name "SpiceMapping") "1 2") 
        (field (name "Spice_Primitive") "R")) 
      (libsource (lib "sallen_key_schlib") (part "R") (description "")) 
      (property (name "Fieldname") (value "Value")) 
      (property (name "SpiceMapping") (value "1 2")) 
      (property (name "Spice_Primitive") (value "R")) 
      (property (name "Sheetname") (value "")) 
      (property (name "Sheetfile") (value "sallen_key.kicad_sch")) 
      (sheetpath (names "/") (tstamps "/")) 
      (tstamps "00000000-0000-0000-0000-0000578906ff")) 
    (comp (ref "R2") 
      (value "1k") 
      (fields 
        (field (name "Fieldname") "Value") 
        (field (name "SpiceMapping") "1 2") 
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In Spice format, the netlist is as follows:

ネットリストについての注釈

ネットリスト名の注意事項
Many software tools that use netlists do not accept spaces in component names, pins, nets, or other fields.
Avoid using spaces in pins, labels, names, and value fields of components to ensure maximum compatibility.

In the same way, special characters other than letters and numbers can cause problems. Note that this
limitation is not related to KiCad, but to the netlist formats that can then become untranslatable by other
software that reads those netlist files.

Spice netlists
Spice simulators expect simulation commands ( .PROBE , .AC , .TRAN , etc.) to be included in the netlist.

Any text line included in the schematic diagram starting with a period ( . ) will be included in the netlist. If a
text object contains multiple lines, only the lines beginning with a period will be included.

.include  directives for including model library files are automatically added to the netlist based on the
Spice model settings for the symbols in the schematic.

他のフォーマット
KiCad supports custom netlist generators for exporting netlists in other formats. Some examples of netlist
generators are given in the custom netlist generators section.

A netlist generator is a script or program that converts the intermediate netlist file created by KiCad into the
desired netlist format. The intermediate netlist file contains all of the netlist information required to create
an arbitrary netlist for the schematic. Python and XSLT are commonly used tools to create custom netlist
generators.

Adding new netlist generators
New netlist generators are added by clicking the Add Generator…  button.

.title KiCad schematic 

.include "ad8051.lib" 
XU1 Net-_C2-Pad1_ /lowpass VDD VSS /lowpass AD8051 
C2 Net-_C2-Pad1_ GND 100n 
C1 /lowpass Net-_C1-Pad2_ 100n 
R2 Net-_C2-Pad1_ Net-_C1-Pad2_ 1k 
R1 Net-_C1-Pad2_ Net-_R1-Pad2_ 1k 
V1 Net-_R1-Pad2_ GND AC 1 
V2 VDD GND DC 10 
V3 GND VSS DC 10 
.ac dec 10 1 1Meg 
.end
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New generators require a name and a command. The name is shown in the tab label, and the command is run
whenever the Export Netlist button is clicked.

When the netlist is generated, KiCad creates an intermediate XML file which contains all of the netlist
information from the schematic. The generator command is then run in order to transform the intermediate
netlist into the desired netlist format.

The netlist command must be set up properly so that the netlist generator script takes the intermediate
netlist file as input and outputs the desired netlist file. The %I  argument represents the input intermediate
netlist filename and the %O  argument represents the output netlist filename. The exact netlist command will
depend on the generator script used.

コマンドライン・フォーマット
Consider the following example which uses xsltproc  to generate a netlist in PADS ASC format. xsltproc
converts the intermediate netlist using the netlist_form_pads-pcb.asc.xsl  stylesheet to define the output
format:

xsltproc -o %O.net /usr/share/kicad/plugins/netlist_form_pads-pcb.asc.xsl %I

The purpose of each part of the command is as follows:

xsltproc A tool to convert an XML file (the
intermediate netlist) according to an XSLT
stylesheet.

-o %O.net Output filename. %O  is replaced with the
name of the intermediate netlist file,
which is <schematic name>.xml .
Therefore in this example the complete
output filename is <schematic
name>.xml.net . An arbitrary output
filename can be specified if desired with -
o <filename> .

/usr/share/kicad/plugins/netlist_form_pads-

pcb.asc.xsl

XSLT stylesheet which determines how
the output is formatted. This particular
stylesheet is included with KiCad, but
custom stylesheets can also be created.

%I Input (intermediate netlist) filename. %I
is replaced with the name of the
intermediate netlist file, which is
<schematic name>.xml .

For netlist generators that do not use xsltproc , the generator command will differ.
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中間ネットリスト・ファイル・フォーマット
See the custom netlist generators section for more information about netlist generators, a description of the
intermediate netlist format, and some examples of netlist generators.
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カスタマイズされたネットリストと BOM (部品表)
ファイルの生成
中間ネットリスト
BOM files and netlist files can be converted from an Intermediate netlist file created by KiCad.

このファイルは XML フォーマットで書かれており、中間ネットリストと呼ばれています。この中間ネットリスト
には設計中の基板に関する大量のデータが含まれており、後処理で部品表 (BOM) やさまざまなレポートを生成す
ることができます。

出力するファイル(部品表 (BOM) かネットリスト)次第で、中間ネットリストの利用される部分が変わってきま
す。

回路図のサンプル

中間ネットリストのサンプル
上記の回路図に対応する中間ネットリスト (XML文法を利用しています) を以下に示します。



113

<?xml version="1.0" encoding="utf-8"?> 
<export version="D"> 
  <design> 
    <source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
    <date>29/08/2010 20:35:21</date> 
    <tool>eeschema (2010-08-28 BZR 2458)-unstable</tool> 
  </design> 
  <components> 
    <comp ref="P1"> 
      <value>CONN_4</value> 
      <libsource lib="conn" part="CONN_4"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2141</tstamp> 
    </comp> 
    <comp ref="U2"> 
      <value>74LS74</value> 
      <libsource lib="74xx" part="74LS74"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20BA</tstamp> 
    </comp> 
    <comp ref="U1"> 
      <value>74LS04</value> 
      <libsource lib="74xx" part="74LS04"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20A6</tstamp> 
    </comp> 
    <comp ref="C1"> 
      <value>CP</value> 
      <libsource lib="device" part="CP"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2094</tstamp> 
    </comp> 
    <comp ref="R1"> 
      <value>R</value> 
      <libsource lib="device" part="R"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E208A</tstamp> 
    </comp> 
  </components> 
  <libparts> 
    <libpart lib="device" part="C"> 
      <description>Condensateur non polarise</description> 
      <footprints> 
        <fp>SM*</fp> 
        <fp>C?</fp> 
        <fp>C1-1</fp> 
      </footprints> 
      <fields> 
        <field name="Reference">C</field> 
        <field name="Value">C</field> 
      </fields> 
      <pins> 
        <pin num="1" name="~" type="passive"/> 
        <pin num="2" name="~" type="passive"/> 
      </pins> 
    </libpart> 
    <libpart lib="device" part="R"> 
      <description>Resistance</description> 
      <footprints> 
        <fp>R?</fp> 
        <fp>SM0603</fp> 
        <fp>SM0805</fp> 
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新しいネットリスト形式への変換
中間ネットリストファイルに後処理のフィルターリングをすることで、部品表 (BOM) ファイルのような他形式の
ファイルを生成できます。この変換はテキストからテキストへの変換なので、この後処理フィルターは、Python
や XSLT など、入力として XML を扱える処理系で記述できます。

XSLT itself is an XML language very suitable for XML transformations. There is a free program called
xsltproc that you can download and install. The xsltproc program can be used to read the Intermediate XML
netlist input file, apply a style-sheet to transform the input, and save the results in an output file. Use of
xsltproc requires a style-sheet file using XSLT conventions. The full conversion process is handled by KiCad,
after it is configured once to run xsltproc in a specific way.

XSLT のアプローチ
XSL 変換 (XSLT) に関するドキュメントは、下記より参照することが出来ます:

http://www.w3.org/TR/xslt

PADS-PCB 形式ネットリストファイルの生成
PADS-PCB 形式のネットリストは、次の２つのセクションより構成されます。

フットプリントの一覧

ネットリスト：ネット情報によりグループ化されたパッド情報

以下に、中間ネットリストから pads-pcb 形式へ変換するためのスタイルシートを掲載します。:

http://www.w3.org/TR/xslt
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<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to PADS netlist format 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
    How to use: 
        https://lists.launchpad.net/kicad-developers/msg05157.html 
--> 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<xsl:template match="/export"> 
    <xsl:text>*PADS-PCB*&nl;*PART*&nl;</xsl:text> 
    <xsl:apply-templates select="components/comp"/> 
    <xsl:text>&nl;*NET*&nl;</xsl:text> 
    <xsl:apply-templates select="nets/net"/> 
    <xsl:text>*END*&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each component --> 
<xsl:template match="comp"> 
    <xsl:text> </xsl:text> 
    <xsl:value-of select="@ref"/> 
    <xsl:text> </xsl:text> 
    <xsl:choose> 
        <xsl:when test = "footprint != '' "> 
            <xsl:apply-templates select="footprint"/> 
        </xsl:when> 
        <xsl:otherwise> 
            <xsl:text>unknown</xsl:text> 
        </xsl:otherwise> 
    </xsl:choose> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each net --> 
<xsl:template match="net"> 
    <!-- nets are output only if there is more than one pin in net --> 
    <xsl:if test="count(node)>1"> 
        <xsl:text>*SIGNAL* </xsl:text> 
        <xsl:choose> 
            <xsl:when test = "@name != '' "> 
                <xsl:value-of select="@name"/> 
            </xsl:when> 
            <xsl:otherwise> 
                <xsl:text>N-</xsl:text> 
                <xsl:value-of select="@code"/> 
            </xsl:otherwise> 
        </xsl:choose> 
        <xsl:text>&nl;</xsl:text> 
        <xsl:apply-templates select="node"/> 
    </xsl:if> 
</xsl:template> 
 
<!-- for each node --> 
<xsl:template match="node"> 
    <xsl:text> </xsl:text> 
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xsltproc を実行し得られた、PADS-PCB 用のネットリストファイルを以下に示します。:

この変換は、次のコマンドラインにより実行することができます：

CADSTAR 形式のネットリストファイルの生成
CADSTAR 形式のネットリストは、下記の２セクションで構成されています。

フットプリントの一覧

ネットリスト：ネット情報によりグループ化されたパッド情報

以下に変換するためのスタイルシートを掲載します。:

*PADS-PCB* 
*PART* 
P1 unknown 
U2 unknown 
U1 unknown 
C1 unknown 
R1 unknown 
*NET* 
*SIGNAL* GND 
U1.7 
C1.2 
U2.7 
P1.4 
*SIGNAL* VCC 
R1.1 
U1.14 
U2.4 
U2.1 
U2.14 
P1.1 
*SIGNAL* N-4 
U1.2 
U2.3 
*SIGNAL* /SIG_OUT 
P1.2 
U2.5 
U2.2 
*SIGNAL* /CLOCK_IN 
R1.2 
C1.1 
U1.1 
P1.3 
 
*END*

kicad\\bin\\xsltproc.exe -o test.net kicad\\bin\\plugins\\netlist_form_pads-pcb.xsl 
test.tmp
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<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format 
    Copyright (C) 2010, Jean-Pierre Charras. 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<!-- Netlist header --> 
<xsl:template match="/export"> 
    <xsl:text>.HEA&nl;</xsl:text> 
    <xsl:apply-templates select="design/date"/>  <!-- Generate line .TIM <time> --> 
    <xsl:apply-templates select="design/tool"/>  <!-- Generate line .APP <eeschema version> 
--> 
    <xsl:apply-templates select="components/comp"/>  <!-- Generate list of components --> 
    <xsl:text>&nl;&nl;</xsl:text> 
    <xsl:apply-templates select="nets/net"/>          <!-- Generate list of nets and 
connections --> 
    <xsl:text>&nl;.END&nl;</xsl:text> 
</xsl:template> 
 
 <!-- Generate line .TIM 20/08/2010 10:45:33 --> 
<xsl:template match="tool"> 
    <xsl:text>.APP "</xsl:text> 
    <xsl:apply-templates/> 
    <xsl:text>"&nl;</xsl:text> 
</xsl:template> 
 
 <!-- Generate line .APP "eeschema (2010-08-17 BZR 2450)-unstable" --> 
<xsl:template match="date"> 
    <xsl:text>.TIM </xsl:text> 
    <xsl:apply-templates/> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each component --> 
<xsl:template match="comp"> 
    <xsl:text>.ADD_COM </xsl:text> 
    <xsl:value-of select="@ref"/> 
    <xsl:text> </xsl:text> 
    <xsl:choose> 
        <xsl:when test = "value != '' "> 
            <xsl:text>"</xsl:text> <xsl:apply-templates select="value"/> <xsl:text>"
</xsl:text> 
        </xsl:when> 
        <xsl:otherwise> 
            <xsl:text>""</xsl:text> 
        </xsl:otherwise> 
    </xsl:choose> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each net --> 
<xsl:template match="net"> 
    <!-- nets are output only if there is more than one pin in net --> 
    <xsl:if test="count(node)>1"> 
    <xsl:variable name="netname"> 
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CADSTAR 形式の出力ファイルです。

OrCAD PCB2 形式ネットリスト・ファイルの生成
このフォーマットは、フットプリントの一覧のみで構成されています。それぞれのフットプリントは接続されるネ
ットの情報を含みます。

変換を行うためのスタイルシートファイルを、以下に示します。

.HEA 

.TIM 21/08/2010 08:12:08 

.APP "eeschema (2010-08-09 BZR 2439)-unstable" 

.ADD_COM P1 "CONN_4" 

.ADD_COM U2 "74LS74" 

.ADD_COM U1 "74LS04" 

.ADD_COM C1 "CP" 

.ADD_COM R1 "R" 
 
 
.ADD_TER U1.7 "GND" 
.TER     C1.2 
         U2.7 
         P1.4 
.ADD_TER R1.1 "VCC" 
.TER     U1.14 
         U2.4 
         U2.1 
         U2.14 
         P1.1 
.ADD_TER U1.2 "N-4" 
.TER     U2.3 
.ADD_TER P1.2 "/SIG_OUT" 
.TER     U2.5 
         U2.2 
.ADD_TER R1.2 "/CLOCK_IN" 
.TER     C1.1 
         U1.1 
         P1.3 
 
.END
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<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
    How to use: 
        https://lists.launchpad.net/kicad-developers/msg05157.html 
--> 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<!-- 
    Netlist header 
    Creates the entire netlist 
    (can be seen as equivalent to main function in C 
--> 
<xsl:template match="/export"> 
    <xsl:text>( { Eeschema Netlist Version 1.1  </xsl:text> 
    <!-- Generate line .TIM <time> --> 
<xsl:apply-templates select="design/date"/> 
<!-- Generate line eeschema version ... --> 
<xsl:apply-templates select="design/tool"/> 
<xsl:text>}&nl;</xsl:text> 
 
<!-- Generate the list of components --> 
<xsl:apply-templates select="components/comp"/>  <!-- Generate list of components --> 
 
<!-- end of file --> 
<xsl:text>)&nl;*&nl;</xsl:text> 
</xsl:template> 
 
<!-- 
    Generate id in header like "eeschema (2010-08-17 BZR 2450)-unstable" 
--> 
<xsl:template match="tool"> 
    <xsl:apply-templates/> 
</xsl:template> 
 
<!-- 
    Generate date in header like "20/08/2010 10:45:33" 
--> 
<xsl:template match="date"> 
    <xsl:apply-templates/> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- 
    This template read each component 
    (path = /export/components/comp) 
    creates lines: 
     ( 3EBF7DBD $noname U1 74LS125 
      ... pin list ... 
      ) 
    and calls "create_pin_list" template to build the pin list 
--> 
<xsl:template match="comp"> 
    <xsl:text> ( </xsl:text> 
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OrCAD PCB2 形式の出力ファイルです。

Netlist plugins interface
Intermediate Netlist converters can be automatically launched within the Schematic Editor.

ダイアログウィンドウの初期化
新しいネットリストプラグインをユーザインタフェースへ追加するには、“プラグインの追加” ボタンをクリックし
ます。

PADS-PCB タブの設定は、下記のようになります:

( { Eeschema Netlist Version 1.1  29/08/2010 21:07:51 
eeschema (2010-08-28 BZR 2458)-unstable} 
 ( 4C6E2141 $noname P1 CONN_4 
  (  1 VCC ) 
  (  2 /SIG_OUT ) 
  (  3 /CLOCK_IN ) 
  (  4 GND ) 
 ) 
 ( 4C6E20BA $noname U2 74LS74 
  (  1 VCC ) 
  (  2 /SIG_OUT ) 
  (  3 N-04 ) 
  (  4 VCC ) 
  (  5 /SIG_OUT ) 
  (  6 ? ) 
  (  7 GND ) 
  (  14 VCC ) 
 ) 
 ( 4C6E20A6 $noname U1 74LS04 
  (  1 /CLOCK_IN ) 
  (  2 N-04 ) 
  (  7 GND ) 
  (  14 VCC ) 
 ) 
 ( 4C6E2094 $noname C1 CP 
  (  1 /CLOCK_IN ) 
  (  2 GND ) 
 ) 
 ( 4C6E208A $noname R1 R 
  (  1 VCC ) 
  (  2 /CLOCK_IN ) 
 ) 
) 
*
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プラグインの設定パラメータ
The netlist plug-in configuration dialog requires the following information:

タイトル: ネットリストフォーマットの名前など

変換を行うためのコマンドライン

ネットリストボタンをクリックすると、次のように実行されます。

1. KiCad creates an intermediate netlist file *.xml, for instance test.xml.

2. KiCad runs the plug-in by reading test.xml and creates test.net.

コマンドラインからのネットリストファイルの生成
xsltproc.exe を利用して中間ネットリストへスタイルシートを適用する場合、下記のコマンドにより xsltproc.exe
が実行されます。

xsltproc.exe -o <output filename> < style-sheet filename> <input XML file to convert>

Windows 環境で KiCad を利用している場合のコマンドラインは以下のようになります。

f:/kicad/bin/xsltproc.exe -o "%O" f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Linux環境の場合のコマンドを以下に示します。

xsltproc -o "%O" /usr/local/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Where netlist_form_pads-pcb.xsl is the style-sheet that you are applying. Do not forget the double quotes
around the file names, this allows them to have spaces after the substitution by KiCad.

コマンドラインフォーマットはファイル名のパラメータを受け付けます:

サポートしているフォーマットパラメータを下記に示します:

%B ⇒ 選択された出力ファイルのパスとファイル名から、パスと拡張子を除いたもの。

%I ⇒ 現在の入力ファイル（中間ネットリストファイル）の完全なパスとファイル名。

%O ⇒ ユーザが選んだ出力ファイルの完全なパスとファイル名。

%I は実際の中間ネットリストファイル名へ置換されます。

%O は実際の出力ファイル名へ置換され、最終的なネットリストファイルとなります。
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コマンドラインフォーマット: xsltproc の例
xsltproc のコマンドラインフォーマットは、下記のようになります：

<path of xsltproc> xsltproc <xsltproc parameters>

Windows環境の場合:

f:/kicad/bin/xsltproc.exe -o "%O" f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Linux環境の場合:

xsltproc -o "%O" /usr/local/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

上記は、xsltproc が Windows 環境下で kicad/bin 以下にインストールされていると仮定したものです。

BOM （部品表）の生成
中間ネットリストファイルは、使用されているコンポーネント全ての情報を含んでいるため、ここから BOM（部
品表）を生成することができます。以下に BOM（部品表）を生成させるための、Windows (Linux) 環境下でのプ
ラグイン設定ウィンドウを示します:

bom2csv.xsl のパスは、システムによって異なります。現状で最適な BOM （部品表）を生成する XSLT スタイル
シートは、ここでは bom2csv.xsl とします。

コマンドラインフォーマット: python スクリプトの例
python を使用した場合のコマンドラインフォーマットは、下記のようになります:

python <script file name> <input filename> <output filename>

Windows環境の場合:

python *.exe f:/kicad/python/my_python_script.py "%I" "%O"

Linux環境の場合:

python /usr/local/kicad/python/my_python_script.py "%I" "%O"

（あなたの PC に python がインストールされている必要があります。）

中間ネットリストファイルの構造
ネットリストファイルの例を次に示します。
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<?xml version="1.0" encoding="utf-8"?> 
<export version="D"> 
  <design> 
    <source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
    <date>29/08/2010 21:07:51</date> 
    <tool>eeschema (2010-08-28 BZR 2458)-unstable</tool> 
  </design> 
  <components> 
    <comp ref="P1"> 
      <value>CONN_4</value> 
      <libsource lib="conn" part="CONN_4"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2141</tstamp> 
    </comp> 
    <comp ref="U2"> 
      <value>74LS74</value> 
      <libsource lib="74xx" part="74LS74"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20BA</tstamp> 
    </comp> 
    <comp ref="U1"> 
      <value>74LS04</value> 
      <libsource lib="74xx" part="74LS04"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20A6</tstamp> 
    </comp> 
    <comp ref="C1"> 
      <value>CP</value> 
      <libsource lib="device" part="CP"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2094</tstamp> 
    <comp ref="R1"> 
      <value>R</value> 
      <libsource lib="device" part="R"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E208A</tstamp> 
    </comp> 
  </components> 
  <libparts/> 
  <libraries/> 
  <nets> 
    <net code="1" name="GND"> 
      <node ref="U1" pin="7"/> 
      <node ref="C1" pin="2"/> 
      <node ref="U2" pin="7"/> 
      <node ref="P1" pin="4"/> 
    </net> 
    <net code="2" name="VCC"> 
      <node ref="R1" pin="1"/> 
      <node ref="U1" pin="14"/> 
      <node ref="U2" pin="4"/> 
      <node ref="U2" pin="1"/> 
      <node ref="U2" pin="14"/> 
      <node ref="P1" pin="1"/> 
    </net> 
    <net code="3" name=""> 
      <node ref="U2" pin="6"/> 
    </net> 
    <net code="4" name=""> 
      <node ref="U1" pin="2"/> 
      <node ref="U2" pin="3"/> 
    </net> 
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一般的なネットリストファイルの構造
中間ネットリストファイルは、次の５つのセクションで構成されています。

ヘッダーセクション

コンポーネントセクション

ライブラリーパーツセクション

ライブラリーセクション

ネットセクション

このファイルは <export> タグで囲まれたものとなります。

ヘッダーセクション
このヘッダは <design> タグで囲まれます。

このセクションはコメントセクションとして捉えることができます。

コンポーネントセクション
このコンポーネントセクションは <components> タグで囲まれたものとなります。

このセクションには、回路図中で使用されているコンポーネントの一覧が含まれます。それぞれのコンポーネント
は、次のように記載されます。:

<export version="D"> 
... 
</export>

<design> 
<source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
<date>21/08/2010 08:12:08</date> 
<tool>eeschema (2010-08-09 BZR 2439)-unstable</tool> 
</design>

<components> 
<comp ref="P1"> 
<value>CONN_4</value> 
<libsource lib="conn" part="CONN_4"/> 
<sheetpath names="/" tstamps="/"/> 
<tstamp>4C6E2141</tstamp> 
</comp> 
</components>
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libsource name of the lib where this component was found.

part component name inside this library.

sheetpath path of the sheet inside the hierarchy: identify the sheet within
the full schematic hierarchy.

tstamps (time stamps) time stamp of the schematic file.

tstamp (time stamp) time stamp of the component.

コンポーネントのタイムスタンプに関する注意
ネットリスト（つまり基板上）のコンポーネントを識別する際、タイムスタンプ情報はコンポーネントに固有の情
報となります。一方で、KiCad はコンポーネントを基板上の対応するフットプリントから識別する方法を補助的に
用意しています。これは、回路図プロジェクト中のコンポーネントを再アノテーションできるようにし、コンポー
ネントとフットプリント間の結びつき情報を消失しないようにするためのものです。

タイムスタンプは、それぞれのコンポーネントや回路図プロジェクト内のシートにおいて固有の識別子です。しか
しながら、複雑な階層構造内で同じシートが複数回参照される場合、同じタイムスタンプを持つコンポーネントが
存在することになってしまいます。

このような複雑な階層構造を持つシートでは、シートのパス情報を利用して固有の識別子を持ちます。コンポーネ
ントは、“そのシートのパス＋タイムスタンプ” を固有の識別子として持ちます。

ライブラリーパーツ・セクション
このライブラリーパーツセクションは、<libparts>タグで囲まれたものとなり、このセクションは回路図ライブラ
リーの情報を定義するものとなります。このセクションは、次のものを含みます：

The allowed footprints names (names use wildcards) delimiter <fp>.

<fields>で定義されるフィールド

<pins>で定義されるピンリスト

<comp ref="P1"> 
<value>CONN_4</value> 
<libsource lib="conn" part="CONN_4"/> 
<sheetpath names="/" tstamps="/"/> 
<tstamp>4C6E2141</tstamp> 
</comp>
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<pin num=“1” type=“passive”/> のような行は、ピンの電気的な種類を定義するものです。有効なピンの種類は、
次のものがあります。

Input 通常の入力

Output 通常の出力

Bidirectional 入力または出力

Tri-state バスの入出力

Passive 受動部品のピン

Unspecified 不明な種類

Power input コンポーネントの電源入力

Power output レギュレータ IC のような部品の電源出力

Open collector アナログコンパレータでよくみられるオープンコレクタ出力

Open emitter ロジック IC でみられるオープンエミッタ出力

Not connected 回路図上でオープン（未接続）とすべきピン

ライブラリー・セクション
ライブラリーセクションは<libraries>タグで囲まれたものとなります。このセクションはプロジェクトから利用さ
れているライブラリー情報を含みます。

<libparts> 
<libpart lib="device" part="CP"> 
  <description>Condensateur polarise</description> 
  <footprints> 
    <fp>CP*</fp> 
    <fp>SM*</fp> 
  </footprints> 
  <fields> 
    <field name="Reference">C</field> 
    <field name="Valeur">CP</field> 
  </fields> 
  <pins> 
    <pin num="1" name="1" type="passive"/> 
    <pin num="2" name="2" type="passive"/> 
  </pins> 
</libpart> 
</libparts>
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ネット・セクション
ネットセクションは<nets>タグで囲まれたものとなります。このセクションは、回路図上の接続情報を定義するも
のです。

このセクションでは、回路図上の全てのネットを羅列します。

ネット情報の例を次に示します。

net code ネットの内部的な識別番号

name ネット名

node ネットに接続されるピン

xsltproc に関する追加情報
次の Web ページを参照してください: http://xmlsoft.org/XSLT/xsltproc.html

<libraries> 
  <library logical="device"> 
    <uri>F:\kicad\share\library\device.lib</uri> 
  </library> 
  <library logical="conn"> 
    <uri>F:\kicad\share\library\conn.lib</uri> 
  </library> 
</libraries>

<nets> 
  <net code="1" name="GND"> 
    <node ref="U1" pin="7"/> 
    <node ref="C1" pin="2"/> 
    <node ref="U2" pin="7"/> 
    <node ref="P1" pin="4"/> 
  </net> 
  <net code="2" name="VCC"> 
    <node ref="R1" pin="1"/> 
    <node ref="U1" pin="14"/> 
    <node ref="U2" pin="4"/> 
    <node ref="U2" pin="1"/> 
    <node ref="U2" pin="14"/> 
    <node ref="P1" pin="1"/> 
  </net> 
</nets>

<net code="1" name="GND"> 
  <node ref="U1" pin="7"/> 
  <node ref="C1" pin="2"/> 
  <node ref="U2" pin="7"/> 
  <node ref="P1" pin="4"/> 
</net>

http://xmlsoft.org/XSLT/xsltproc.html
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はじめに
xsltproc は XSLT スタイルシートを XML 文書に適用するためのコマンドラインツールです。これは GNOME プロ
ジェクトの一環として開発され、GNOME デスクトップ環境が無くても利用することが可能です。

xsltproc はスタイルシート名と適用するファイル名をオプションとし、コマンドラインより起動されます。標準入
力を利用する場合、ファイル名には – 記号を利用します。

スタイルシートが XML 文書内に含まれている場合、コマンドラインでスタイルシート名を指示する必要はありま
せん。xsltproc は自動的にスタイルシートを検出し利用します。標準では、出力が 標準出力(stdout) となってい
ます。ファイルとして結果を出力したい場合には、 -o オプションを利用します。

概要

コマンドラインオプション
-V 又は --version

利用している libxml と libxslt のバージョン情報を表示します。

-v 又は --verbose

xsltproc がスタイルシートとドキュメントを処理する各段階でメッセージを出力します。

-o 又は --output file

<ファイル名>で指定されたファイルへ結果を出力します。「チャンク」などとして知られているように、複数出力
したい場合は -o ディレクトリ名/ として指定したディレクトリへファイルを出力します。この場合、ディレクトリ
は予め作成しておく必要があります。

--timing

スタイルシートの構文解析、ドキュメントの構文解析、スタイルシートの適用、結果の保存にかかった時間を表示
します。ミリ秒の単位で表示されます。

--repeat

タイミングテストの為に、変換を20回繰り返し実行します。

--debug

デバッグの為に、変換されたドキュメントの XML ツリーを出力します。

--novalid

ドキュメントの DTD の読み込みをスキップします。

xsltproc [[-V] | [-v] | [-o *file* ] | [--timing] | [--repeat] | 
[--debug] | [--novalid] | [--noout] | [--maxdepth *val* ] | [--html] | 
[--param *name* *value* ] | [--stringparam *name* *value* ] | [--nonet] | 
[--path *paths* ] | [--load-trace] | [--catalogs] | [--xinclude] | 
[--profile] | [--dumpextensions] | [--nowrite] | [--nomkdir] | 
[--writesubtree] | [--nodtdattr]] [ *stylesheet* ] [ *file1* ] [ *file2* ] 
[ *....* ]
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--noout

結果を出力しません。

--maxdepth ＜値＞

libxsltの無限ループを防ぐため、テンプレートの最大スタック深度を調整します。デフォルトは500 です。

--html

HTML ファイルを入力ファイルとします。

--param ＜パラメータ名＞＜値＞

スタイルシート中の、パラメータで指定された<パラメータ名> name および<値> value の処理を行いません。パ
ラメータ名と値のペアは、最大 32 個まで指定することができます。値をノードの識別ではなく、文字列として処
理したい場合は、--stringparam オプションを利用してください。

--stringparam <パラメータ名> <値>

<パラメータ名> name と<値> value で指定された値について、ノードの識別ではなく文字列として扱うようにし
ます。（注：これら文字列は utf-8 エンコードされている必要があります。）

--nonet

DTDのエンティティやドキュメントをインターネットから取得しません。

--path <パス>

DTDやエンティティ、ドキュメントの読み込みに、 <パス> で指定されたファイルのリスト（半角スペースやカン
マで区切られる）を使用します。

--load-trace

処理中に読み込まれた全てのドキュメントを、標準エラー出力 (stderr) へ出力します。

--catalogs

SGML_CATALOG_FILES 内で指定された SGML カタログを外部エンティティの解決に利用します。標準では、
xsltproc は XML_CATALOG_FILES で指定された場所を探します。XML_CATALOG_FILES が定義されていない場
合、/etc/xml /catalog を利用します。

--xinclude

Xincludeの仕様に基づき、入力ドキュメントの処理を行います。Xincludeの詳細は、次を参照してください：
http://www.w3.org/TR/xinclude/[http://www.w3.org/TR/xinclude/]

--profile --norman

スタイルシートのそれぞれのパーツの処理時に、プロファイル情報の詳細を出力します。これはスタイルシートの
パフォーマンスを最適化するために利用できます。

--dumpextensions

登録済みの拡張子のリストを標準出力 (stdout) へ出力します。

http://www.w3.org/TR/xinclude/
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--nowrite

ファイルやリソースへの書き込みを行いません。

--nomkdir

ディレクトリを作成しません。

--writesubtree <パス>

<パス> で指定されたパス内のファイルのみ書込します。

--nodtdattr

ドキュメント内DTDの標準アトリビュートを適用しません。

Xsltproc の戻り値
xsltproc はスクリプトからの呼び出し時などに利用しやすいよう、戻り値でステータスを返します。

0: 通常

1: 引数なし

2: パラメータが多すぎる

3: 不明なオプション

4: スタイルシートの構文解析に失敗 (parse error)

5: スタイルシート内にエラー

6: ドキュメントのひとつにエラー

7: 未サポートの xsl : 出力メソッド

8: 文字列パラメータがクオートとダブルクオートの両方を含んでいる

9: 内部処理エラー

10: 中断シグナル (CTRL+C など) により処理を終了

11: 出力ファイルに書き込めない

xsltproc に関する追加情報
libxml web ページ: http://www.xmlsoft.org/

W3C XSLTページ: http://www.w3.org/TR/xslt

http://www.xmlsoft.org/
http://www.w3.org/TR/xslt
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シミュレーター
KiCad provides an embedded electrical circuit simulator using ngspice as the simulation engine.

シミュレーターを使う場合には、公式 pspice ライブラリーが役に立ちます。これには、電圧源や電流源、ngspice
ノード順の仕様に合ったピン番号を持つトランジスターのような、シミュレーションに使われる共通シンボルが含
まれています。

シミュレーターができることを説明するためのデモ・プロジェクトも用意されています。これらは
demos/simulation ディレクトリーにあります。

モデルの割り当て
シミュレーションを実行する前に、Spice モデルを部品に割り当てる必要があります。

各部品はモデルを１つだけ持つことができます。例え複数ユニットを持っていたとしても１つのみで、この場合に
は、最初のユニットが指定されたモデルを持つことになります。

Spice 表記 (抵抗 R*、コンデンサー C*、インダクター L*) のデバイス・タイプと一致したリファレンスを持つ受動
部品は、暗黙的に割り当てられたモデルを持っており、プロパティの決定には定数フィールドの値が使われます。

NOTE Spice 表記では 'M' はミリ、'Meg' はメガであることに留意して下さい。もし 'M' をメガという
接頭辞としたいのであれば、シミュレーション設定ダイアログで設定することができます。

Spice モデルの情報はシンボルのフィールドにテキストとして保存されており、シンボル・エディターまたは回路
図エディターで定義することができます。シンボル・プロパティのダイアログを開き、 Spice モデルを編集 ボタン
をクリックして Spice モデル・エディターのダイアログを開いて下さい。

Spice モデル・エディターのダイアログは、モデルの種類に応じた３つのタブを持っています。全てのモデルの種
類で共通のオプションは２つあります。

http://ngspice.sourceforge.net/
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““

Disable symbol for
simulation

When checked the component is excluded from simulation.

Alternate node sequence Allows one to override symbol pin to model node mapping. To
define a different mapping, specify pin numbers in order
expected by the model.

'Example:' 

* connections:  

* 1: non-inverting input  

* 2: inverting input  

* 3: positive power supply  

* 4: negative power supply  

* 5: output  

.subckt tl071 1 2 3 4 5

To match the symbol pins to the Spice model nodes shown
above, one needs to use an alternate node sequence option with
value: "1 3 5 2 4". It is a list of pin numbers corresponding to the
Spice model nodes order.

パッシブ
パッシブ・タブで受動部品 (抵抗、コンデンサー、インダクター) の割り当てができます。これは、あまり使われ
ないオプションで、部品のリファレンスが実際のデバイス・タイプと一致しない場合を除いて、通常の受動部品は
暗黙的に割り当てられたモデルを持っています。

NOTE

明示的に定義された受動部品のモデルは、暗黙的に割り当てられたモデルに優先します。これ
は、受動部品のモデルが割り当てられたなら、シミュレーション中はリファレンスと定数のフ
ィールドが無視されることを意味します。従って、割り当てられたモデルの定数と回路図シー
トにある定数が異なっているときは、混乱を招くことがあります。
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タイプ デバイス・タイプ (抵抗、コンデンサーあるいはインダクター) を選
択します。

定数 部品の属性 (抵抗値、静電容量またはインダクタンス) を定義しま
す。 値には Spice で一般的な単位の接頭辞を使えます。(テキスト入
力フィールドの下にリスト表示) また小数点には "." を使わなければ
なりません。Spice は値の間に入っている接頭辞を正しく 解釈でき
ないことに注意して下さい。(例 1k5)
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モデル
モデル・タブは半導体や外部のライブラリー・ファイルで定義された複雑なモデルの割り当てに使われます。
Spice モデルのライブラリーは、多くの場合、部品メーカーによって提供されます。

メインのテキスト部分には、選択されたライブラリー・ファイルの内容が表示されます。通常は、ライブラリー・
ファイル内部にある、ノード順を含んだモデル記述となります。
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ライブラリー Spice ライブラリー・ファイルのパス。このファイルは、.include 指
令を使って追加され、 シミュレーターで使われます。

モデル 選択されたデバイス・モデル。ファイルが選択されているとき、リ
ストには選択可能なモデルが 表示されます。

タイプ モデル・タイプ (サブ回路、BJT、MOSFETやダイオード) の選択 。
通常は、モデル選択時に 自動でセットされます。

ソース
ソース・タブは電源や信号源モデルの割り当てに使用されます。２つのセクション: DC/AC 解析 と 過渡応答解析
があります。各々、シミュレーション・タイプに応じて、ソースのパラメーターを定義します。

ソース・タイプ・オプションは全てのシミュレーション・タイプに適用されます。
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ソースに関するより詳細な情報は、 ngspice ドキュメント、chapter 4 (Voltage and Current Sources) を参照して
下さい。

Spice 指令
回路図シートのテキスト・フィールドで Spice 指令を追加することが可能です。この方法はデフォルトのシミュレ
ーション・タイプを定義する時に便利です。この機能はドットで始まる Spice 指令 (例 ".tran 10n 1m") に限定され
ます。テキスト・フィールドを使って追加の部品を配置することはできません。

http://ngspice.sourceforge.net/docs/ngspice-27-manual.pdf
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シミュレーション
シミュレーションを開始するには、回路図エディターのメニューから ツール→シミュレーター を選択して Spice
シミュレーター・ダイアログを開きます。

ダイアログはいくつかのセクションに分かれています。

ツールバー

プロット・パネル

出力コンソール

信号リスト

カーソル・リスト

調整パネル

メニュー

ファイル
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新規プロット プロット・パネルに新しいタブを作成する。

ワークブックを開く プロットされた信号のリストを開く。

ワークブックを保存 プロットされた信号のリストを保存する。

画像として保存 アクティブなプロットを png ファイルにエクスポートする。

.csv ファイルとして保存 アクティブなプロットの元のポイント・データを .csv ファイルにエ
クスポートする。

シミュレーションを終了 ダイアログを閉じる。

シミュレーション

シミュレーションを実行 現在の設定を使ってシミュレーションを実行する。

信号を追加… プロットする信号を選択するダイアログを開く。

回路図からプローブ 回路図のプローブ・ツールを起動する。

コンポーネント定数を調整 調整・ツールを起動する。

SPICE ネットリストを表
示… 

回路シミュレーション用に生成されたネットリストを表示する ダイ
アログを開く。

設定… シミュレーション設定ダイアログを開く。

表示

ズーム・イン アクティブなプロットをズーム・イン。

ズーム・アウト アクティブなプロットをズーム・アウト。

スクリーンにフィット 全てのプロットを表示するようにズームを調整。

グリッドの表示 グリッドの可視性をトグルで切り替え。

凡例の表示 プロット凡例の可視性をトグルで切り替え。

ツールバー

上部ツールバーは頻繁に繰り返し実行される機能を呼び出すためのものです。
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実行/停止 シミュレーションの開始と停止。

信号を追加 プロットする信号を選択するダイアログを開く。

プローブ 回路図のプローブ・ツールを起動する。

調整 調整・ツールを起動する。

設定 ,シミュレーション設定ダイアログを開く。

プロット・パネル
シミュレーション結果をプロットして可視化する。開かれている別のタブにも複数プロットすることができます
が、シミュレーション実行時に更新されるのはアクティブなタブだけです。このように、異なったシミュレーショ
ンの実行結果を比較できるようになっています。

プロットは、 表示・メニューを使って、グリッドと凡例の可視性をトグル動作でカスタマイズ可能です。凡例が
表示されているときは、ドラッグで位置を変更することができます。

プロット・パネルでの操作:

マウス・ホイールのスクロールで、ズーム・イン/ズーム・アウト

コンテキスト・メニューを開いて右クリックで、表示の調整

矩形選択で、選択された領域をズーム

カーソルのドラッグで、座標の変更

出力コンソール
出力コンソールは、シミュレーターからのメッセージを表示します。エラーや警告がないことの確認用に出力コン
ソールをチェックすることをお勧めします。

信号リスト
アクティブなプロットで表示された信号のリストを表示します。

信号リストでの操作:

コンテキスト・メニューを開いて右クリックで、信号の非表示またはカーソルのON/OFF

ダブル・クリックで、信号の非表示

カーソル・リスト
カーソルとその座標のリストを表示します。各信号には表示されたカーソルが１つあります。カーソルの可視性は
信号・リストを使って設定されます。

調整パネル
調整・ツールでピックアップされた部品を表示します。調整パネルでは、部品定数の変更によるシミュレーション
結果への影響を迅速に 調べることができます。 (部品定数が変更される毎に、シミュレーションが再実行されてプ
ロットが更新されます。)

各部品には、関係する幾つかのコントロールかあります:
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最上部のテキスト・フィールドには、部品定数の最大値がセットされます。

中間のテキスト・フィールドには、実際の部品定数がセットされます。

最下部のテキスト・フィールドには、部品定数の最小値がセットされます。

スライダーを使うと、部品定数をスムーズに可変できます。

_保存_ボタンを押すと、回路図の部品定数はスライダーで選択された値に変更されます。

_X_ボタンを押すと、調整パネルから部品が削除されて部品定数は元の値に復元されます。

３つのテキスト・フィールドでは、Spice での単位の接頭辞を使用できます。

調整ツール
調整ツールは、調整する部品をピックアップするためのものです。

調整する部品を選択するには、ツールを起動してから回路図エディターで部品をクリックします。選択された部品
は、調整・パネルに表示されます。調整できるのは受動部品だけです。

プローブ・ツール
プローブ・ツールを使うと、プロットする信号を簡単に選択できます。

プロットする信号を追加するには、ツールを起動してから回路図エディター上で対応する線をクリックします。
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シミュレーションの設定

シミュレーション設定ダイアログは、シミュレーション・タイプとパラメーターを設定するためのものです。４つ
のタブがあります:

AC

DC伝送

過渡応答

カスタム

最初の３つのタブがシミュレーションのパラメーターを指定するためのフォームです。最後のタブは、ユーザーが
カスタマイズしたシミュレーション設定用の Spice 指令を入力するためのものです。シミュレーション・タイプと
パ ラ メ ー タ ー に つ い て の よ り 詳 細 な 情 報 は 、 http://ngspice.sourceforge.net/docs/ngspice-27-
manual.pdf[ngspice documentation], chapter 1.2.で見つけることができます。
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シミュレーションを設定する別の方法は、回路図上のテキスト・フィールドに Spice 指令を入力することです。シ
ミュレーション・タイプに関連したテキスト・フィールドでの指令は、常にダイアログで選択された設定で上書き
されます。これは、シミュレーション・ダイアログを使ってシミュレーションを開始したなら、シミュレーターを
再起動するまでダイアログが回路図の指令を上書きすることを意味します。

全てのシミュレーション・タイプで共通のオプションが２つあります:

受動部品シンボルの定数を
調整

一般的な部品定数の表記を Spice 表記へ変換するために受動シンボ
ルの定数を置換する。

.include ライブラリー指令
の絶対パスを追加

前にパスが追加された Spice モデル・ライブラリー・ファイルの 名
前、ライブラリー・ファイルのフル・パス。通常、ngspice はライブ
ラリー・ファイルにアクセスするために フル・パスを必要としま
す。
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